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Overview of this manual
About this manual

This manual is designed as a step-by-step guide to learn the sequence of work
when you work with Cutting PowerPac.
General steps are:

• Create a cutting station. See Setting up a cutting station on page 31
• Create paths. See Manage paths on page 49
• Verify and optimize paths. See Path optimization on page 143
• Load program to the controller. See Virtual controller settings on page 157

Usage
This referencemanual contains general and specific information about the Cutting
PowerPac tools and workflow.

Who should read this manual?
This manual should be used by anyone working with Cutting PowerPac.

Prerequisites
You should have a basic knowledge of:

• RobotStudio
• RAPID
• Cutting process

References

Document IDReference

3HAC032104-001Operating manual - RobotStudio

3HAC050941-001Operating manual - IRC5 with FlexPendant

3HAC050947-001Technical reference manual - RAPID Overview

3HAC050917-001Technical reference manual - RAPID Instructions, Functions and
Data types

Revisions

DescriptionRevision

First edition-

Released with RobotStudio 5.15A
The following updates are made:

• 3D free form cutting function has been improved.
• Cutting parameter tables are added.
• New calibration method is added.

Continues on next page
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DescriptionRevision

Released with RobotStudio 5.61B
The following updates are made:

• Few sections are rearranged.
• Few images are updated.
• Minor editorial corrections are done.

Released with RobotStudio 6.0C
Following are the updates:

• Updated various sections in the chapter User interface
on page 23.

• Updated the chapter Path simulation on page 155.

Released with RobotStudio 6.0D
Following are the updates:

• Updated the sectionCreating a Part program on page63.
• Added the section Modify multiple instructions on

page 116.

Released with RobotStudio 6.01E
Following is the update:

• Updated the section Work flow of importing station
components.

Released with RobotStudio 6.02F
Following are the updates:

• Added the section Synchronize on page 153.
• Removed the section Work flow of importing station

components.

Released with RobotStudio 6.04G
Following is the update:

• Updated the sectionCreate calibration points on page55.

Released with RobotStudio 2019.1.H
Updated the references.
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1 Introduction and installation
1.1 Introduction to Cutting PowerPac

About Cutting PowerPac
Cutting PowerPac is a tool for generating cutting programs in RobotStudio. Utilizing
the CAD geometry as the basis for all robotics programming, you can generate 2D
and 3D shape cutting instructions based on geometry features, and also generate
free form cutting path base on the edges. This method, known as geometry-based
offline programming, gives you control over the cutting paths, resulting in improved
quality.

About this chapter
This chapter will guide you through the installation process.

Prerequisites
To complete the installation process, you must have the following items:

• RobotStudio and RobotWare Cutting installed on your computer.
• Cutting PowerPac installation package.
• A license certificate.
• A logon account with administrator rights.

Operating manual - Cutting PowerPac 9
3HAC043509-001 Revision: H

© Copyright 2012-2019 ABB. All rights reserved.

1 Introduction and installation
1.1 Introduction to Cutting PowerPac



1.2 Robotics terminology

1.2.1 Robot positions

About positions
The exact position of the robot is determined using the position of the resolvers
and counters that count the number of resolver revolutions. These are called
revolution counters. If the robot is correctly calibrated then the current position is
automatically calculated at start.

How robot positions are displayed
Positions are always displayed as:

• The point in space expressed in the x, y, and z tool center point coordinates.
• The angular rotation of the tool center point expressed in Euler angles or as

a quaternion.
Typical positioning information required by robots:

xx1300001131

Position format
The position can be displayed in different formats.
The position can be displayed relative to the following frames:

• World
• Base
• Work object

The Orientation format can be set to:
• Quaternion
• Euler angles

The Position angle format can be set to:
• Angles

Continues on next page
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The Presentation angle unit can be set to:
• Degrees
• Radians
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1.2.2 Singularity

Description
Arm singularities are all configurations where the wrist center (the intersection of
axes 4,5 and 6) ends up directly above axis 1.

xx1300001132

Wrist singularities are configurations where axis 4 and axis 6 are on the same line,
that is axis 5 has an angle equal to 0.

xx1300001133
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1.2.3 Typical frames/coordination systems

Overview
This section provides an introduction to the coordinate systems used mostly for
offline programming. In RobotStudio, you can either use the coordinate systems
(that are explained below) or the user-defined coordinated systems for co-relating
elements and objects.

Coordinate systems
A frame/coordinate system defines a plane or space by axes from a fixed point
called the origin. Robot targets and positions are located by measurements along
the axes of coordinate systems.
A robot uses several coordinate systems, each suitable for specific types of jogging
or programming.

• The base coordinate system is located at the base of the robot. It is the
easiest one for just moving the robot from one position to another.

• The work object coordinate system is related to the work piece and is often
the best one for programming the robot.

• The tool coordinate system defines the position of the tool the robot uses
when reaching the programmed targets.

• The world coordinate system that defines the robot cell, all other coordinate
systems are related to the world coordinate system, either directly or
indirectly. It is useful for jogging, general movements and for handling stations
and cells with several robots or robots moved by external axes.

• Reference Coordinate System (RCS) is used to create andmanipulate targets
in RobotStudio. Like workobject coordinate system or User Cordinate system,
Reference Coordinate System can also be used to set the target location
and angle.

• The user coordinate system is useful for representing equipment that holds
other coordinate systems, like work objects.

The coordinate systems are co-related hierarchically. The origin of each coordinate
system is defined as a position in one of its ancestries. The following are the
descriptions of the commonly used coordinate systems.

Base coordinate system (BCS)
The base coordinate system is called the Base Frame (BF). Each robot in the
station, both in RobotStudio and the real world has a base coordinate systemwhich
is always located at the base of the robot.

Continues on next page
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Work object coordinate system
A coordinate system referenced to an work object is called an work object
coordinate system. This coordinate system is also very suited to off-line
programming since the positions specified can usually be taken directly from a
drawing of the work object. The work object coordinate system can also be used
when jogging the robot.
The work object coordinate system is defined based on the user coordinate system.
That means it must be defined in two frames, the user frame (related to the world
frame) and the object frame (related to the user frame).

xx1300001135

The programmed positions are always defined relative to a work object coordinate
system.
If a fixture is moved/turned, this can be compensated for by moving/turning the
user coordinate system. Neither the programmed positions nor the defined work
object coordinate systems need to be changed. If the work object is moved/turned,
this can be compensated for bymoving/turning the work object coordinate system.
If the user coordinate system is movable, that is, coordinated additional axes are
used, then the object coordinate system moves with the user coordinate system.
This makes it possible to move the robot in relation to the object even when the
workbench is being manipulated.

Tool center point (TCP) coordinate system
TCP is the tool center point coordinate system. Different TCPs can be defined for
one robot, but only one may be active at a time. All robots have one predefined
TCP at the robot’s tool mounting point, called tool0.
The position of the robot and its movements are always related to the tool center
point. This point is normally defined as being the center point of the tool or

Continues on next page
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somewhere on the tool, for example, at the cutting head tip of a laser cutting gun,
at the center of a gripper or at the end of a grading tool.
When a program runs, the robot moves the TCP to the programmed position. When
a position is recorded, it is the position of the TCP that is recorded. This is also
the point that moves along a given path at a given velocity.
A tool is an object that can be mounted directly or indirectly on the robot turning
disk or fitted in a fixed position within the robot working range. A fixture or a cutting
gun is not a tool.
All tools must be defined with a TCP. Each tool that can be used by the robot must
be measured and its data stored in order to achieve accurate positioning of the
tool center point.

xx1300001134

Tool sideA

Robot sideB

World Coordinate system (WCS)
The RobotStudio world coordinate system represents the entire station or robot
cell. This is the top of the hierarchy to which all other coordinate systems are related
(when using RobotStudio).

User Coordinate System (UCS)
The user coordinate system is used to get different coordinate systems for different
fixtures or working surfaces. A fixture, however, may include several work objects
that are to be processed or handled by the robot. Thus, it often helps to define a
coordinate system for each object in order to make it easier to adjust the program
if the object is moved or if a new object, the same as the previous one, is to be
programmed at a different location.

Continues on next page
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Reference Coordinate System (RCS)
In Cutting PowerPac, every robtarget is associated with a local reference coordinate
system called Reference Coordinate System (RCS).
RCS is primarily used to help create and manipulate targets in RobotStudio. As
workobject/UCS, RCS can be used to set the target location and angle.
Usually a target's RCS accommodates the shape of the part geometry. For example,
for cutting targets along a cut path, the RCS positions are along the cut path, the
x axis directions are along the path direction, and the z axis directions are along
the normal vector of the cut surface. Thus, instead of entering target values in
relation to a world coordinate or a work object, you can specify offsets and angles
relative to the RCS, which have a more direct space relationship between robot
targets and the cut.

xx1300001143

Task Frame (TF)
The Task Frame represents the origin of the robot controller world coordinate
system in RobotStudio.
The following picture illustrates the difference between the base frame and the
task frame.

Continues on next page
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In the picture to the left, the task frame is located at the same position as the robot
base frame. In the picture to the right, the taskframe has been moved to another
position.

en1000001303

The task frame in RobotStudio is mapped to the robot controller coordinate system
in the real world, for example, on the work shop floor.

en1000001304

Object Frame
The object frame is based on the user frame. Users can define the object frame
by two means:

• Position. Assign the origin of the object frame, a point on X axis, a point on
XY platform to define the frame.

• Three-point. Assign the first point on X axis, the second point on X axis and
a point on Y axis to define the frame.
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1.2.4 Robot configuration

Axis configurations
Targets are defined and stored as coordinates in a Workobject coordinate system.
When the controller calculates the position of the robot axes for reaching the target,
it will often find more than one possible solution to configuring the robot axes.

configur

Storing axis configurations in targets
For targets that are taught after jogging the robot to the position, the used
configuration will be stored in the target.
Targets created by specifying or calculating positions and orientations get a default
configuration value (0,0,0,0), which might not be valid for reaching the target.

Common problems and solutions related to robot axis configurations
It is most likely that targets created by other ways than jogging cannot be reached
at their default configuration.
Even if all targets in a path have validated configurations, you might encounter
problems when running the path if the robot cannot move from one configuration
to the other. This is likely to occur where an axis shifts greater than 90 degrees
during linear movements.
Repositioned targets keep their configuration, but the configurations are no longer
validated. As a result, the problems described above might occur when moving
targets.
Common solutions for configuration problems are:

• To resolve the problems described above, you can assign a valid configuration
to each target and verify that the robot can move along each path.

• You can also turn configuration monitoring off, which means that you ignore
the stored configurations and let the robot find working configurations at
runtime. If this is not done the proper way, youmight get unexpected results.

• In some cases there might not be any working configurations. Possible
solutions might then be to reposition the work piece, reorient targets (if
acceptable for the process) or add an external axis that either moves the
work piece or the robot for increasing reachability.

Continues on next page
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How configurations are denoted
The robot’s axis configurations are denoted by a series of four integers, specifying
in which quadrant of a full revolution significant axes are located. The quadrants
are numbered from zero for positive (counterclockwise) rotation and from -1 for
negative (clockwise) rotation.
For a linear axis, the integer specifies the range (in meters) from the neutral position
in which the axis is located.
A configuration for a six-axis industrial robot (like IRB 140) may look like: [0 -1 2
1]
The first integer (0) specifies the position of axis 1: somewhere in the first positive
quadrant (between 0 and 90 degrees rotation). The second integer (-1) specifies
the position of axis 4: somewhere in the first negative quadrant (between 0 and
-90 degrees rotation). The third integer (2) specifies the position of axis 6:
somewhere in the third positive quadrant (between 180 and 270 degrees rotation).
The fourth integer (1) specifies the position of axis x, a virtual axis used for
specifying the wrist center in relation to other axes.
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1.2.5 Other

Generic data
Besides default RAPID data types, such as robtarget and tooldata, PowerPacs
also uses other data types. These are called generic data. In Cutting PowerPac,
some process related data, such as cutdata, leaddata, and fricdata are
supported.
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1.3 Installing Cutting PowerPac

Overview
To install Cutting PowerPac, RobotStudio and RobotWare Cuttingmust be installed
on your computer.

Installing Cutting PowerPac
To install the Cutting PowerPac, follow these steps:

1 Browse to Cutting PowerPac installation package and double-clickSetup.exe.
The installation opens.

2 Click Install Cutting PowerPac.
The installation starts.

3 Read the License Agreement and accept the terms.
4 Click Install.
5 When the installation is finished, complete the installation wizard by clicking

Finish.

Installing a license
RobotStudio works without activation for a trial period of 30 days. By default, the
Cutting PowerPac is also activated after installation . After 30 days, the RobotStudio
activation key is required to activate Cutting PowerPac Add-on.
To activate Cutting PowerPac, use the Activation Wizard of RobotStudio.
RobotStudio activation automatically activates the Cutting PowerPac Add-on also.
To verify the activation status of Cutting PowerPac:

1 Click File > Options > Licensing.
2 Click View Installed License Keys to view the status of your current license.

Operating manual - Cutting PowerPac 21
3HAC043509-001 Revision: H

© Copyright 2012-2019 ABB. All rights reserved.

1 Introduction and installation
1.3 Installing Cutting PowerPac



1.4 Programing workflow

Overview
This chapter is designed as a step-by-step guide to learn the sequence of work
when you work with Cutting PowerPac. To work with Cutting PowerPac follow the
procedure.

• Setting up a cutting station on page 31
• Manage paths on page 49
• Path optimization on page 143
• Path view on page 91
• Data management on page 147
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2 User interface
2.1 Start and close Cutting PowerPac

Overview
Before you can start using Cutting PowerPac, youmust load a RobotStudio station
that includes at least one cutting robot. The virtual controller (VC) associated with
the cutting robot must be loaded.

Start Cutting PowerPac
To start Cutting PowerPac:

1 Open a RobotStudio cutting station.
2 On the Add-Ins tab in the ribbon, select Cutting from the PowerPacs group.

A dedicated tab for Cutting is added to the ribbon.
3 Click the Cutting tab.

The Cutting PowerPac user interface is displayed.

Close Cutting PowerPac
To close Cutting PowerPac, click theClose Cutting button above the Cutting ribbon
tab. The Cutting PowerPac is closed.
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2.2 User interface

The user interface
The following figure and table provide details about the Cutting PowerPac user
interface.

xx1300001142

DescriptionItemLa-
bel

Contains the general functions for Cutting process.Cutting ribbon1

Displays the components of the station in a tree structure.Cutting browser2

Categorizes and linearly maps the targets.Path view window3

The graphics window is coordinated with these panes: a path
highlighted in the browser, is highlighted with the same color
in the graphics window. A simulation appearing in the graphics
window is represented in the path view by a robot cursor step-
ping through the path in the path view.

3D Graphics window4

The graphics window is an important source to input geometry
targets. By clicking on the part models in the window, you can
create or modify a target in the geometry space.

The Cutting ribbon
The Cutting ribbon contains the controls for creating paths, virtual controller
operations, modifying Cutting PowerPac data, and help information.

xx1300001144

Continues on next page
24 Operating manual - Cutting PowerPac

3HAC043509-001 Revision: H
© Copyright 2012-2019 ABB. All rights reserved.

2 User interface
2.2 User interface



Elements on the cutting ribbon-tab:

DescriptionButtonGroup

Opens a dialog box to create a new setup path and
inserts a new path node into the tree structure. For
more details, see Create/edit setup and service pro-
cedures on page 50.

Note

You can access this function also from the Cutting
browser by right-clicking the Setup Procedures node.

Setup PathCreate

Opens a dialog box to create a new service path and
inserts a new path node into the tree structure. For
more details, see Create/edit setup and service pro-
cedures on page 50.

Note

You can access this function also from the Cutting
browser by right-clicking the Service Procedures
node.

Service Path

Creates 3 to 10 calibration points to get the transition
relationship of the offline calibration points on the CAD
model and the calibration points on the work object in
the real laser cutting work.

Calibration

Opens a dialog box to create a new part program, in-
sert a new part node into the tree structure, and cre-
ates an empty path. For more details, see Create or
edit Part programs on page 62.

Note

You can access this function also from the Cutting
browser by right-clicking the Part Programs node.

Part Program

See Create or edit Part programs on page 62 for the
definition for part program.

Inserts a new empty path node into the tree structure.

Note

This button is available only when a part node or a
path node under the part node is selected in the Cut-
ting browser. You can access this function also from
the Cutting browser by right-clicking the Process Path
node.

Process Path

See Create/edit Process paths on page 72for the
definition for process path.

Creates a free form cutting. For more details, seeCre-
ate Free Form Cutting on page 99.

Path Section

This button is available after a path or the last instruc-
tion of a free form cutting path is selected.

2D Shape Data

Continues on next page
Operating manual - Cutting PowerPac 25
3HAC043509-001 Revision: H

© Copyright 2012-2019 ABB. All rights reserved.

2 User interface
2.2 User interface

Continued



DescriptionButtonGroup
Opens a dialog box to select a face from the CAD
model, and saves the corresponding 2D shape data
into a .cad file which is used to create a 2D shape cut
instruction. For more information, see Create Shape
Data From Edges Dialog Box on page 114.

Verifies whether the robot can reach all the targets on
the path, and if collision exists in the cutting procedure.
Available only when a free form cutting path is selec-
ted. See Check path on page 144

Check pathOptimization

Verifies whether the robot canmove to the laser cutting
points in the created cutting path.

Move to path

Opens the Data Manager dialog box, which lists all the
related data in the current station.

Data ManagerData

SeeOverview on page147 for the detailed description
of data manager.

Click to create and edit laser cutting parameter tables.
See LS Cutting parameter tables on page 39 for de-
tailed information regarding to Laser Table.

Laser Table

Synchronizes the program to the virtual controller.Synchronize To RAP-
ID

Virtual con-
troller

Loads the default program into VC for the active task.
Usually the default program is null.

Load Default Program

Saves the current program in the virtual controller.Save Program
The program is saved to a predefined directory. The
folder name is: Station name"_"Task name. For
example, for the task T_ROB1 in station
Irb140_250A_RW_5_11, its storing directory is
HOME\Irb140_250A_RW_5_11_T_ROB1.

Opens the synchronization settings dialog box.Options

Continues on next page
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DescriptionButtonGroup

Simulates the cutting procedure in the 3D graphical
window.

PlaySimulation

Pauses the simulation.Pause

Stops the simulation of the laser cutting procedure in
the 3D graphic window.

Stop

Restores the path to the status at the beginning of the
simulation.

Reset

Move/rotate frames in the station or adjust joints of
the robot.

Free handFreehand

Provides the following information:
• Help file
• Cutting PowerPac version information

Cutting PowerPac
Help

Help

Continues on next page
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Cutting browser
The tree structure of the Cutting browser provides an overview of the controllers,
robots, templates, programs, and calibrations.

xx1300001175

For more details, see Manage paths on page 49.

Output/Path view
There are two tabs in the Output/Path view.

xx1300001176

DescriptionItem

Displays the messages including general system messages, RAPID
messages, controller messages, simulation messages, event log, and
application messages.

Output

Displays a window where you can create, modify, view paths, change
configuration, and the virtual commissioning of the paths. For more de-
tails, see Path view on page 91.

Path view

Continues on next page
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3D Graphic window
It is a 3D view interface where you can choose view settings, control graphics view,
create new views, view/hide the selected targets, frames, paths, parts and
mechanisms. For more details, see Operating manual - RobotStudio.
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3 Setting up a cutting station
3.1 Create a station with a robot system

Overview
This section describes how to create a system and build a cutting station.
The system points out the robot models and options to use, and it also stores
configurations and programs for the robots. You can create a station with a template
system or with an existing system. Inmost cases, a virtual controller is automatically
started when you create a new station. Library files for the robot used by the system
are then imported to the station.

Building a new system
The following procedure shows the workflow for building a new system.

Note

This procedure is applicable only if you are using RobotWare versions prior to
RobotWare 6.0. From RobotWare 6.0 onwards Installation Manager is used for
building a system. Formore information about building a system using Installation
Manager, see Operating manual - RobotStudio.

1 Click System Builder on the Controller ribbon-tab.
The System Builder window is displayed.

2 Click Create New.
The New Controller System window is displayed.

3 Click Next.
4 Type a name for the system in Name field and select a path in the Path field.
5 Click Next.
6 Select the Virtual Key option.

The controller key is displayed in the Controller Key field.

Note

The RobotWare keys determine which RobotWare versions and parts to
use in the system. Creating a system to run on either IRC5 controller or
virtual controllers requires at least two keys: one for the controller module
and one for each drive module in the cabinet.

7 Click Next.
8 Click the arrow button to add the drive key to the Added Drive Keys field.
9 Click Next.
10 In the Enter Key field browse to the location ...\ABB Industrial IT\Robotics

IT\Mediapool\CUTTING and select the key.

Continues on next page
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11 Click on the arrow button to move the selected key to the Added options
list.

12 Click Next.
13 Select the required options from the Modify Options window.
14 Click Finish.

The system is created in the specified location.
15 Click Close.

Create a station
The station can be created in three ways:

DescriptionActivity

This is the simplest way to create a
new station containing a robot and
a link to a rudimentary system.
Available robot models are listed.
After selection, RobotStudio will
automatically create a matching
virtual controller.

Click File-> New -> Station with Robot Controller to
create a station with a template system

Create a new station containing one
or more robots, and add an existing
built system to it.

Click File-> New -> Station with existing Robot Con-
troller to create a station with an existing system

An advanced users can build a sta-
tion from scratch and then add a
new or an existing system to it.

Click File-> New -> Empty Station to create a station
with no system
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4 Manage templates
4.1 Creating templates

Overview
Before the first cut path is created, you should create your own process template,
modify the properties related with cutting parameters and motion instructions.
When instructions are created, the instructions automatically use the created
templates.When the template is modified, all the related instructions automatically
use the modified template.
For detailed information, see Manage templates on page 33.
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4.2 Process templates

Overview
A process template in Cutting PowerPac is a collection of templates for process
parameters, cutting targets, instruction arguments, and so on. It specifies the
information needed to create a complete cutting on the part. Cutting PowerPac is
installed with default process templates, such as ProcessAsMove and CutDefault.

Shortcut menus from the Process Templates node

DescriptionMenuNode

Imports predefined process templates.ImportProcess

Allows you to view and modify the properties of a
process template.

Properties

Creates a copy of a selected process template.Create Copy

Saves the selected process template to disk.Save

Deletes the selected process template.Delete

Importing a process template
The process templates are based on several instructions. For example, the
ProcessAsMove template includes instructions for MoveL, MoveJ and MoveC.
These default move instructions are always available in the virtual controller. The
Cut Default template (included in the Cutting PowerPac installation) uses
instructions such as CutL and CutC. These are available in a virtual controller
installed with the option Cutting.

1 Right-click the process node and click Import. In the Import Process
Template dialog box, select the corresponding template and click Open.

2 An error message appears if the underlying instructions for the template are
not found in the controller. In this case, RobotStudio must be told how these
instructions should be handled. This should be done manually in the
Instruction Template Manager in RobotStudio or by importing a predefined
description file.
If the template is successfully imported, the related process definitions will
be automatically added into RobotStudio. Do not manually modify or delete
any of these process definitions in the Instruction Template Manager.

Modifying process templates
1 In the Cutting browser, right-click a template and click Properties to open a

dialog box.
2 Modify any values. To store your changes without closing the dialog box,

click Apply. To store your changes and close the dialog box, click OK. To
close the dialog box without storing any changes, click Cancel.

Continues on next page
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Process template properties
In the Cutting browser, right-click a template and click Properties to open a dialog
box.

xx1300001181

DescriptionSection

A data field for entering a text description of the process template.
This information is not transferred to the RAPID code.

Description

Optional.Process Parameters
The values can be obtained from a Cutting case, or manually modi-
fied. If selected, the property values will be used as target settings
in Create Free Form Cutting.

A process template is associated with a RobotStudio base process
definition file. The definition file contains all the instruction templates
used by the process template, and is imported into RobotStudio by
Cutting PowerPac.

Base RS Process
Definitions

Usually you do not need to change the association between a pro-
cess template and a definition file. However if such a case occurs,
you can select a different definition here, export the process template
and import into Cutting PowerPac again.

Continues on next page
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DescriptionSection

Templates section.Templates
Settings for RAPID instructions. Instruction parameters (for example,
motion type, speed, zone) will be set for all targets depending on
the target classification.
If an argument is generic data, a Create new... appears in the drop-
down list. If selected, a dialog box opens to create a new data of
this type. Input the name of the new argument, then click the ...
button after the argument button and edit the data.
Clicking the button can start the Data Editor, where sync properties
and data values can bemodified. SeeDataManager on page148 for
more information.

Targets in a cutting process
The following figure illustrates a typical sequence of targets in a cutting process.

xx1300001182

Cutting targets will be assigned with process parameters in accordance with one
of the following classifications:

DescriptionTarget

Intermediate target between cutting paths. Generates a MoveJ or
MoveL instruction, depending on the motion type.

Air Move

The first target before a cutting path. Generates a MoveJ or MoveL
instruction, depending on the motion type. Is connected to the fol-
lowing Process Start target, so that the orientation always follows
the process start point with a variable approach distance.

Approach Move

The first target in a cutting path. Generates a CutLStart instruction,
activating the cutting process.

Process Start

The intermediate target in a cutting path. Generates a CutL or CutC
instruction, depending on the motion type.

Process Via

The last target in a cutting path. Generates a CutLEnd or CutCEnd
instruction depending on the motion type. Deactivate the cutting
process.

Process End

The first target after a cutting path. Generates a MoveL instruction.
It is connected to the preceding Process End Target, so that the
orientation always follows the process end point with a variable
depart distance.

Depart Move
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4.3 Cut templates

Overview
A cut template is a collection of cutting creation methods. See Create Free Form
Cutting on page 99 for detail.

Operating manual - Cutting PowerPac 37
3HAC043509-001 Revision: H

© Copyright 2012-2019 ABB. All rights reserved.

4 Manage templates
4.3 Cut templates



4.4 Tool properties template

Overview
Since the tool model in RobotStudio differs from the tool in reality, Cutting PowerPac
must know the geometry of the activated tool to be able to calculate correct cutting
head angles based on the search parameters.
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4.5 LS Cutting parameter tables

Overview
LS cutting parameter tables contain two kinds of cutting process parameters:
cutting parameters and piercing parameters. It can help cutting experts to save
and maintain good cutting parameters in the PC and let the users select cut data
group configurations according to rules during offline programming. Users can
create, edit LS cutting parameter tables and view existing parameter tables in the
cutting browser.
In each parameter table, there can be up to 5 cutting groups and 5 pierce groups
for users to choose.

Continues on next page
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View and edit LS cutting parameter tables
Click LSCutting Parameter Tables, right click on the defaultLsCuttingParamTable,
and select Properties. The Properties:defaultLsCuttingParamTable table is
displayed. This table displays all the existing cutting parameter groups and piercing
parameter groups. You can edit the entries in the Value column by double clicking
it.

xx1300001183

DescriptionSection

General attributes of a cutting parameter table containing general
cutting information such as cutting power, laser type, focal length,
and so on.

Table Head

The name of the cutting parameter table.Cutting Param Table
Name

Displays the cut parameters. There can be a maximum of 5 cutting
parameter groups in the Cutting Param Table Name.

Cut tabs

Continues on next page
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DescriptionSection

Displays the pierce parameters. There can be amaximum of 2 pierce
parameter groups in the Cutting Param Table Name.

Pier tabs

Save LS Cutting Parameter Table
Click LS Cutting Parameter Table, right click on the cutting parameter table to be
saved, and select Save. The Save Cutting Param Tablewindow is displayed. Type
a name in the File name field and click Save. The LS cutting parameter tablesmust
be saved as mod files in the RobotStudio/Systems/[System
Name]/HOME/LsCuttingParamTables path. The mod file can be opened using
a text editor.

Create a LS Cutting Parameter Table

Illustration/NoteDescription

xx1300001184

Right click a process template based
on which the new template should be
created and select Create Copy.

1

xx1300001185

TheCreate Copywindow is displayed.
Type a name in the New Table Name
field and click OK.

2

Edit the properties of the newly created
process according to View and edit LS
cutting parameter tables on page 40.

3

Add parameter groups in the LS Cutting Parameter Table

Illustration/NoteDescription

Open the LS Cutting Parameter table
saved as a mod file. For detailed inform-
ation for how to save the table, please
refer toSave LSCutting Parameter Table
on page 41.

1
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Illustration/NoteDescription

The CuttingParamTableHead sectionAdd the codes for the new group in the
section it belongs. For example, add a
cutting parameter group under the sec-
tion CuttingParamTableHead by copying
an existed cutting parameter table,
pasting it in the existed cutting paramet-
er groups and change the index number
and parameter values of the newly cre-
ated group.

2

The cutting parameter group

Update the parameter of numCut-
tingGroups which indicates the total
number of cutting groups or numberPier-
cingGroups which indicates the total
number of piercing groups.

3

Save the modified mod file.4

Right click the LS Cutting Parameter
Tables button and select Import...,
browse to the modified table in the Im-
port LS Cutting Param Table shows up
afterwards and click Open.

5

Note

The LS Cutting Parameter Table in the cutting browser is saved in the station.
Modification to the LS Cutting Parameter Table after the station has been opened
would be made in the system and would not be synchronized to the station
automatically. So importing the modified parameter table in the cutting browser
must be implemented after the modification of the parameter table.
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Edit LS Cutting parameter tables
Click Laser Table button in the Data group on the Ribbon. The Cutting Table
Checking window is displayed. Select a task and click the LS Cutting Parameter
Tables button. The Properties is displayed.

xx1300001169

You can select the current active (the value in the IsActive column is true) LS
cutting parameter table and click Edit to check the reason of the invalid TableConf
or select a laser table and execute the following operations:

DescriptionAction

Click to create a new LS cutting parameter table with the parameter values
same as that of the default parameter table.

NEW

Continues on next page
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DescriptionAction

Click and open the property interface of a LS cutting parameter table to edit
it.

xx1300001170

EDIT

Click to copy the selected LS cutting parameter table.COPY

Click to delete the selected LS cutting parameter table.

Note

There has to be atleast one laser cutting parameter table.

DELETE

Click to import an existing LS cutting parameter table and save as a *.mod
file.

IMPORT

Click to set the selected LS cutting parameter table as the active laser table
and apply it to all the cutting instructions. The IsActive column of the active
LS cutting parameter table would be true.

ACTIVE

Edit the LS TableConf
You can edit the LS tableconf from the Pathview by double clicking on a target.
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To create a new TableConf:

IllustrationDescription

xx1300001171

Click the ... button after the drop
down list to view/edit the data of the
LS TableConfig.

Note

The \udCutParams is used to con-
trol the laser cutting process and
includes parameters for controlling
the laser head, laser, and also the
cutting gas including pierce and cut
phase. This parameter when used
overrides the udLSTableConf para-
meter.

1

xx1300001172

The Create New... interface would
show up displaying a default value
of the group and the task it belongs
to.
Name the TableConfig with a name
that can show the combination of
the cutting group and the piercing
group.
Select the storage type of the
TableConf from the storage class
dropdown list.
Click OK to confirm.

2

xx1300001173

Click the ... button after the Table-
Conf dropdown list.

3

xx1300001174

An LsTableConf edit/view interface
displaying the detailed information
of the TableConf would show up.
Select the Module that it would be
saved to from the Sync to Module
dropdown list or directly input a new
module name in the Sync toModule
column.
Select the storage class.
Modify IndexCutting and IndexPier-
cing in the Station Data block to
modify the TableConf just created.
Click OK to confirm.

4
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Note

If select a TableConf saved in the LSDefaultData module from the TableConf
dropdown list and click the ... button, the IndexCutting and IndexPiercing data
can not be modified in the LsTableConf edit/view interface displayed.
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4.6 Cutting Param Table rule

Overview
Cutting Param Table Rule sets the following range of five types of cutting groups:

DescriptionRule

Usually for bigger size of 2D shape cutting. Default size would
be 30 to 9999 mm of the maximum diagonal line.

Gen2D

Usually for smaller size of 2D shape cutting. Default size would
be 0 to 30 mm of the maximum diagonal line.

Special2D

Usually for bigger size of 3D shape cutting. Default size would
be 30 to 9999 mm. For linear shape, the minimum length is 30
mm. For circular shape, the minimum diameter is 30 mm.

Gen3D

Usually for smaller size of 3D shape cutting. Default size would
be 0 to 30 mm. For linear shape, the maximum length is 30mm.
For circular shape, the maximum diameter is 30mm.

Special3D

Parameters for piercing.SpecialPiercing

You canmanually set the range of Gen2D and Special2D in the Table Rule interface.
Rules for Gen3D, Special3D and SpecialPiercing are not suggested to bemodified.

Note

After a parameter group is created, a table rule would be automatically assigned
to the group. You can modify the properties of the groups according to the their
shape type.
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4.7 Reload templates

Reloading a templates
The template reload function is used to reload instruction template files saved in
the default directory to the station.
To reload a template:

IllustrationDescription

xx1300001189

Right click the Templates node, and
click Reload.

1

xx1300001190

Amessage would prompt to make users
confirm reload templates in the default
directory or not.

2

Click Yes to confirm reloading, No or
Cancel to quit without reloading.

3
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5 Manage paths
5.1 Overview

Overview
Programming with Cutting PowerPac is an iterative process, which typically begins
with creating paths in the Cutting browser. After opening the Path View, targets,
and instructions are added to the path using process and cut templates, combined
with input from clicking at geometry objects in graphics window.

Creating process paths
The following table shows the workflow:

DescriptionActivity

See Create or edit Part programs on page 62 for
the detailed procedure.

Create a program part node in the
Cutting Browser, which is the holder
of process paths.

1

See Create/edit Process paths on page72 for the
detailed procedure.

Create a Process path.2

SeePath optimization on page143 for the detailed
procedure to verify and optimize by the cutting
ribbon tab and the cutting browser.

Verify and optimize the created path
by the cutting ribbon tab and the
cutting browser or by the path view
window.

3

See Path view on page91 for the detailed proced-
ure to verify and optimize by the path view win-
dow.
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5.2 Create/edit setup and service procedures

Overview
The setup and service procedure nodes provide holders for motion paths that
neither fit into a part program nor include cutting paths. For example, most stations
require a path for moving the robot to its home position.
Further examples of setup and service procedures for an cutting system include
motion paths for the following:

• To and from the home position and the Bulls eye TCP device (service
procedure)

• To and from the home position (service procedure)
• To and from the home position and the service station (service procedure)
• Including targets for frame definition of the IRBP positioner (setup procedure)
• Including targets for TCP definition with the Bulls eye TCP calibration device

(setup procedure)

Shortcut menus from the Setup Procedures node

DescriptionMenuNode

Inserts a new setup path node in the tree
structure.

Note

You can also access this function from the
Cutting ribbon-tab.

Create Setup PathSetupProcedure

Import a path XML file into
station as a setup path.

Import Path

Continues on next page
50 Operating manual - Cutting PowerPac

3HAC043509-001 Revision: H
© Copyright 2012-2019 ABB. All rights reserved.

5 Manage paths
5.2 Create/edit setup and service procedures



DescriptionMenuNode

Modifies the properties of setup path with a
dialog box. The contents of the dialog box
are the same as in Create Setup Path dialog
box.

PropertiesSetup Path

Opens the path in the path view. Not available
on an open path.

Open/Close

Closes an open path, removing it from the
path view. Only available on an open path.

Inserts a new setup path node into the tree
structure.

Note

You can also access this function from the
Cutting ribbon-tab.

Create Setup Path

Synchronizes the selected path to the virtual
controller.

Synchronize to RAPID

Export path into a XML file. The default name
of the file consists of task name and path
name. An dialog box will appear for users to
specify the exporting reference frame.

Export Path

See Exporting a path on page 73for detailed
description.

Import XML path file into the station as a
setup path. A dialog box opens for specifying
import reference, tool, workobject, path name
and module name.

Import Path

Please see Importing a path on page 74for
detailed description.

A checkmark indicates that the selected path
is visible.

Visible

Not available on an open path.

Closes an open path, removing it from the
path view. Only available on an open path.

Delete

Shortcut menus from the Service Procedures node

DescriptionMenuNode

Inserts a new service path node in the tree
structure.

Note

You can also access this function from the
Cutting ribbon-tab.

Create Service PathService Proced-
ure

Import a path XML file into
station as a service path.

Import Path

Continues on next page
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DescriptionMenuNode

Modifies the properties of service path with
a dialog box. The contents of the dialog box
are the same as in the Create Service Path
dialog box.

PropertiesService Path

Opens the path in the path view. Not available
on an open path.

Open/Close

Closes an open path, removing it from the
path view. Only available on an open path.

Inserts a new service path node into the tree
structure.

Note

You can also access this function from the
Cutting ribbon-tab.

Create Service Path

Synchronizes the selected path to the virtual
controller.

RAPID

Export path into a XML file. The default name
of the file consists of task name and path
name. A dialog box opens for specifying the
exporting reference frame.

Export Path

See Exporting a path on page 73 for detailed
description.

Import XML path file into station, as a service
path. A dialog box opens for specifying im-
port reference, tool, workobject, path name,
and module name.

Import Path

See Importing a path on page 74for detailed
description.

A checkmark indicates that the selected path
is visible.

Visible

Not available on an open path.

Closes an open path, removing it from the
path view. Only available on an open path.

Delete
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Creating a setup/service path

xx1300001210

DescriptionObject

Enter a name for the created path.Path Name

Synchronize RAPID module. Default module is mSetup.Module Name

If selected, the menu data will also be created. The information in the
menu data is as the following inputs from the dialog box.

Include Menu
Data

Input a category string for the setup/service path.Category

Get automatic update when entering a new setup/service path.Description

Select tasks in which the new create path runs. Useful when used in a
MultiMove program.

Run in tasks

Continues on next page
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DescriptionObject

Select stations for which this part data will be valid. The value should be
a number from 1 to 8.

Valid on Stations

Select stations for which this part data will be valid. The value should be
a number from 1 to 8.

Valid at Position

If selected, this menu item will be shown after an error occurs.AllowAfter Error

If selected, all other tasks will be blocked during the execution of this
path.

Block Other
Tasks

A unique integer number, to indicate the ID for PLC interface.PLC Code

Select an image for the new created setup/service path. This image can
be shown on Production Manager of the FlexPendant.

Image File

To create a Setup/Service path, follow these steps:
1 In the Cutting browser, right-click the setup/service procedures node or a

setup/service path node and click Create Setup Path Service or Create
Service Path, or click Setup Path or Service Path in the Cutting ribbon-tab
to open the dialog box.

2 Complete the dialog box and click OK. If any RAPID name is invalid, then
clicking OK will not close the dialog box.

Note

After completing the dialog box, you can view the created setup/service path in
the tree structure of the Cutting browser. If the path is selected to be run in
multi-tasks, a new setup/service node with the same name will be created under
each task. This is very useful in a MultiMove station.
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5.3 Create/edit calibrations

Overview
When you simulate the cutting path and process in the RS station on PC, calibration
is needed to transfer the simulated positions in RobotStudio station in PC to real
process positions in the real cutting workshop. RS Cutting PowerPac provides a
standard calibration method with higher accuracy.
You can generate 3 to 10 calibration points based on the 3D CAD model. The first
3 calibration points would be used to get the transition relation, the other calibration
points are used to improve the accuracy. There are two types of calibration points:
general point and circle center point. General point is a point on a regular solid
workpiece. Circle center point is the center of a circular hole which is found using
geometry calculation.

Create calibration points

Creating calibration points
Following is the description of the Calibration window:

xx1300001191

DescriptionObject

Allows you to select a calibration type. It can be calibration of
BaseFrame for robot or positioner, calibration of Tool, or calibration
of WorkObject.

Type

Allows you to select an available instruction templates for the selec-
ted calibration type.

Template

Allows you to select a RAPID module where the calibration instruc-
tions and targets are created.

Module

Continues on next page
Operating manual - Cutting PowerPac 55
3HAC043509-001 Revision: H

© Copyright 2012-2019 ABB. All rights reserved.

5 Manage paths
5.3 Create/edit calibrations



DescriptionObject

Allows you to select an RobotStudio tool to be used for calibration.Tool

Allows you to select a workobject (coordinate system) to which the
calibration targets are related.

Workobject

Allows you to select a number of calibration target. It varies based
on the selected template.

Teach Target

Displays the name of the calibration target.Target Name

Allows you to select the type of move instruction.Move Instruction

Allows you to select the reference frame used for positioning of
calibration targets. It is in sync with the RobotStudio reference
frames.

Reference

Allows you to select the matrix to locate the created targets.Position (mm)

Allows you to select configure the orientation of the target.Orientation (deg)

Creates a target and the Calibration window is refreshed.Create Target andGo
Next

Allows you to modify a target.Modify Target

Allows you to save the changes in a selected target.Confirm

Use the following procedure to create a calibration.

Figure/DescriptionStep

Click theCalibration icon in the
cutting ribbon tab.
The Calibration window is dis-
played.

1

Select a target on the part in
the graphical window.

2

The position of the target is
updated in theCalibrationwin-
dow.

Continues on next page
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Figure/DescriptionStep

xx1600001663

Click theCreate Target andGo
Next button.
The Calibration window is re-
freshed.

3

Note

TheModify target button is used tomodify the position
of a selected target.

Repeat the same steps for all
the targets of the selected tem-
plate.

4

xx1600001664

Click Confirm.
The Calibration window is re-
freshed.

5

Continues on next page
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Figure/DescriptionStep

Click Edit to go back to previous screen and edit the
position of a selected target.

Type a name for the calibration
in theCalibration Routine field.

6

Click View Screenshot to preview the targets. A 3D
view window displaying the corresponding calibration
points on the part is displayed

Click Create Calibration.7
The calibration is created and
the browser window displays
the new calibrations. Also the
Path View is created with the
instructions.

After the creation procedure, the newly created calibration is displayed under the
Calibrations node of the browser tree.

xx1300001195

Procedure to calibrate on FlexPendant

IllustrationDescription

Setup the fixture by mounting
the master workpiece on the
fixture.

1

Replace the cut nozzle with the
teaching tip on the cutting
head.

2

xx1300001128

In the ABB main menu, tap the
Calibration function.

3

Continues on next page
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IllustrationDescription

xx1300001129

The calibration interface is dis-
played.

4

Select the point used in calibra-
tion. And clickGo To. The robot
would go to that position which
also can be marked in the pic-
ture.

5

Jog the robot to the exact posi-
tion on the real work piece, and
tap Modify Position.

6

Modify the other calibration
points’ positions using the
same steps from step 5 to step
6.

7

After all positions of calibration
points have been modified,
click Calibrate. The calibration
would be done.

8

Description for items on the calibration interface:

DescriptionItem

This block can show the detailed information about the current calibration.Status

Displays the currently active tool.Tool

Display the currently active work object.Work object

For all calibration points, the max difference between the offline calibra-
tion point and the corresponding position on real work piece.

Max Error

For all calibration points, the mean variance of the difference between
the offline calibration point and the corresponding position on real work
piece.

Mean Error

The date to do the calibration.Date

Continues on next page
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DescriptionItem

Displays the calibration result.

xx1300001130

Result

Display the calibration list. After select a calibration and click OK. The
selected calibration is displayed.

Settings

Edit calibrations
Double click the newly created calibration, calibration points and the calibrated
work object would be displayed under the node.
Operation about the newly created calibration.

DescriptionItem

Give the calibration another name by right click the calibration to be re-
named and select Rename.

Rename

Delete the calibration by right click the calibration to be deleted and select
Delete.

Delete

Used to show a picture on which the calibration points are marked and
displayed on the work object for users’ convenience to recognize the
calibration points in the calibration process.

ScreenShot

Modify the position of the calibration point by right click a calibration
point and select Property, then click on the work object in the 3D
graphical view window to select a new position for the calibration point.

Property

View the screenshot of calibration points
Use the following procedure to view the screen shot of calibration points:

Description

Right click the calibration whose screenshot to be viewed and
select ScreenShot.

1

View the calibration according to step 6 of Create calibration
points on page 55.

2
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5.4 Create/edit process paths

5.4.1 Overview

Overview
Programming with Cutting PowerPac is an iterative process. The general process
typically is:

1 Add parts in the cutting browser. A part is a container of process paths. When
a part is created, a process path would be automatically created in the part.
For detailed information of create a part, please see Create or edit Part
programs on page 62.

2 Select path section for the process path. For detailed information of create
a cutting, please see Create/edit Process paths on page 72.

Operating manual - Cutting PowerPac 61
3HAC043509-001 Revision: H

© Copyright 2012-2019 ABB. All rights reserved.

5 Manage paths
5.4.1 Overview



5.4.2 Create or edit Part programs

Overview
ThePart Programs node is an owner of a part program. A part program is equivalent
to a program module in RAPID (.mod). In the RAPID module, the part program is
translated into a general RAPID procedure, which includes calls to other RAPID
procedures in a sequence, where each procedure equals to a process path in the
part program.

Shortcut menus from the Part Programs node

DescriptionMenuNode

Inserts a new part node into the tree structure and
creates an empty path.

Note

You can access this function also from the Cutting
ribbon-tab.

Create Part ProgramPart Pro-
grams

Imports XML part files. A dialog box opens for specify-
ing import reference, tool, workobject, part name, path
name, module name, and so on.

Import Part Program

See Importing a Part program on page 68 for detailed
description.

Modifies the properties of part program with a dialog
box. The content is the same as in the Create Part
Program dialog box.

PropertiesPart

Opens the Path view window, and shows the selected
node's path items in that window.

Open

Inserts a new part program node into the tree structure
and creates an empty path.

Note

You can access this function also from the Cutting
ribbon-tab.

Create Part Program

Inserts a new path node into the tree structure.

Note

You can access this function also from the Cutting
ribbon-tab.

Create Process Path

Synchronizes the selected part (and all included paths)
to the virtual controller. Not available if any path in the
part program is open.

Synchronize to RAP-
ID

Export part program into an XML file. The default name
of the file consists of the task name and the part name.
A dialog box opens for specifying the exporting refer-
ence frame.

Export Part Program

See Exporting a Part program on page 67 for detailed
description.
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DescriptionMenuNode

Import an XML part file into station, as a part program.
A dialog box opens for specifying import reference,
tool, workobject, part name, path name, module name,
and so on.

Import Part Program

See Importing a Part program on page 68 for more
description.

Import XML path file into this part, as a process path.
A dialog box opens for specifying import reference,
tool, workobject, path name and module name.

Import Path

See Importing a path on page 74for more description.

Deletes the selected node.Delete

Creating a Part program

Illustration/RemarkDescription

xx1300001196

In the Cutting browser, select the Part
Programs node or a part program node,
right click it and click Create Part Pro-
gram..., or click Part Program in the
Cutting ribbon tab to open the Create
Part Program window.

1

Continues on next page
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Illustration/RemarkDescription

Note

When the Cutting PowerPac is activated, the
active Tool and WorkObject in RobotStudio
Settings becomes dthe efault selection in the
Tool list andWork Object list. After creating
a Part program, the savedWorkObject, Tool,
and Part Component are remembered and
selected automatically while creating sub-
sequent Part programs.

Select the required options.2

xx1400002784

Click Production Manager.
The Production Manager window is
displayed.

3

Note

TheProductionManagerwindow automatic-
ally displays the image of the selected Part
Component in the Create Part Program win-
dow. The image automatically gets saved
under system/HOME directory.

Enter all the needed information and
click OK. If any RAPID names are inval-
id, clicking OK will not close the dialog
box.

4

DescriptionObject

Enter a name for the new part program.Part Name

Get automatic update when entering a new part name.Module Name

Themanagement interface to show the additional information of the
part program.

Production Manager

Select the component for which the cutting part program would be
created. After the selection, the component is displayed in the 3D
graphic view window below.

Part Component

Select the tool to be used to cut from the tool list.Tool

Select the work object coordination system that would be used for
cutting.

Work Object

Set up collision sets to detect if collision exists during the simulation
of the cutting process.

Collision set

Continues on next page
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DescriptionObject

Select a path that runs before the created part program. The path
usually is a service path

Path Before

Click Add to add new empty paths for the part program. You can
also rename the new paths here.

Path List

Select a path that runs after the created part program.Path After

The Production Manager interface

xx1300001197

DescriptionObject

Get automatic update when entering a new part name.Description

If the module is loaded from the file system, this text specifies
the directory.

Load from Directory

Select tasks in which the created part program runs. This is
useful when used in a MultiMove program.

Run in tasks

Select the stations for which this part data will be valid. The
values should be numbers from 1 to 8.

Valid on Stations

A unique integer number to indicate the part program ID in PLC
code.

PLC Code

The partdata can be bound to an advanced path data.Advanced Part Data

Select an image for the created part program. This image can
be shown on Production Manager of the FlexPendant.

Image File

When the image is selected, the size of the image would be
automatically displayed in this field.

Image Size

Continues on next page
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Collision Set

xx1300001198

DescriptionObject

The dropdown list to select a existed collision set or select
to create a new collision set.

Collision Set

The collision set component A and B.Objects A, B

The selected parts in collision set can be displayed with
its 3D model.

3D graphic view window
(marked with 1)

Procedures to create a collision set:

IllustrationDescription

To create a collision set, click the drop down list of Collision Set and
select Create new....

1

A Create CollisionSet interface would show up. Name the new col-
lision set in the interface and click OK.

2

Click the add button to separately add components in Object set A
and B. Click the delete button to delete component from the object
set.

3

Click Apply to confirm the collision set. Click OK to confirm and
quite the collision set interface.

4

To edit a collision set, click the collision set to be edit in the collision set drop down
list and follow steps 3 and 4 of creating a collision set.
After entering all the needed information, you can view the new part program in
the tree structure of Cutting browser. If the part program is selected to be run in
multi-tasks, a new part program node with the same name will be created under
each task.
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66 Operating manual - Cutting PowerPac

3HAC043509-001 Revision: H
© Copyright 2012-2019 ABB. All rights reserved.

5 Manage paths
5.4.2 Create or edit Part programs
Continued



Exporting a Part program
To export a part program into an XML file, follow these steps:

1 In the Cutting browser, select the Part Programs node or a part program
node, right-click it and click Export Part Program to open a dialog box.

xx1300001200

2 Specify a name of the file and a directory to store.
The default name of the file is "Part_"+Task name+ "_" + Part name.
The default directory is under "/My Documents/RobotStudio/Stations".

3 Click Save and a dialog box opens.
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4 Check the data and click OK. The XML file will be saved.

xx1300001201

DescriptionObject

Describes the name of the part, the station, and the task. Read-
only.

Description

The directory where the file is stored. Read-only.Path

The name of the saved file.File Name

A reference where the path targets in the part program are re-
lated to. This affects the position and rotation values of the
targets. The references can beWorld Coordinate, User Coordin-
ate System, robot base coordinate, or work object coordinate.

Reference Frame

The included paths to be exported are listed here. Besides
paths in the selected part, service paths are also listed, in case
you want to export service procedures together with the part
program. Check the service procedures that you want to export
together.

Included Path

Importing a Part program
A file can only be imported as the same object as it was exported. A part can only
be imported as a part.

Continues on next page
68 Operating manual - Cutting PowerPac

3HAC043509-001 Revision: H
© Copyright 2012-2019 ABB. All rights reserved.

5 Manage paths
5.4.2 Create or edit Part programs
Continued



To import a part XML file into the station, please follow the steps:
1 In the Cutting browser, select the Part Programs node or a part program

node, right-click it and click Import Part Program to open a dialog box.

xx1300001202

2 Select a part program file to import and click Open. A message box opens
telling if a wrong type of XML file is selected.
If a wrong type of XML file is selected, a message is shown.
If a right type is selected, a dialog box opens.
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3 Check the data and click OK. The XML file will be imported.

xx1300001203

DescriptionObject

Describes the name of the part, the station, and the task. Read-
only.

Description

Used when the part program is exported. Read-only.ExportedWithRefer-
ence Frame

A reference to import part program. This affects the position
and rotation values of the targets. The references can beWorld
Coordinate, User Coordinate System, robot base coordinate,
or work object coordinate.

Import Reference
Frame

Select the check box to create a new copy of the included
Program Module data; otherwise, old data will be referenced.

Create New Pro-
gram Data

Select the check box to restore configuration status of the in-
cluded targets to when they were exported. Otherwise, the
configuration status is re-set to undefined.

Note

This is a lazy function. Make sure that the targets are indeed
of the same configuration status.

Restore Configura-
tion Status
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DescriptionObject

The tool for the part program. If left blank, the tool from the file
will be used.

Tool

Select workobjects for targets in the part program. If left blank,
the workobject from the file will be used.

Work Object

The synchronized RAPID module of the part program.Module Name

The name of the imported part.Path Name

The name of the process paths in the part.Process Paths
Names

Note

The following rules apply when creating new data and importing XML files:
• If the data is of program data type Sync to Program Module, new

names will be created automatically, unless the Create New Program
Data is unchecked.

• If the data is of another type, such as Sync to Process Data Module,
new data will only be created if it is not present in the station. For
example, a cutdata cd1 that is synchronized to the process datamodule
will not be created again when importing. The old data cd1 will be used
instead.
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5.4.3 Create/edit Process paths

Overview
Process Paths are listed in the Cutting browser under the part programs. As a
component of a part program, a path is a holder of cut in a sequence. Each cut
includes a list of targets that constitute a continuous path. Paths can be dragged
from one part to another; similarly, the order of paths in a part can be rearranged.

Note

A process path created in the Cutting browser is also visible in the Path&Targets
browser in theHome ribbon tab. During synchronization with the virtual controller,
the path is translated into a RAPID procedure.

Shortcut menu from the Process Path node

DescriptionMenuNode

Opens the path in the path view. Not available on an
open path.

OpenPath

Inserts a new path node into the tree structure. Not
available on an open path.

Note

You can access this function also from the Cutting
ribbon-tab.

Create Process Path

Synchronizes the selected path to the virtual controller.
Not available on an open path.

Synchronize to RAP-
ID

Export a path into a XML file. The default name of the
file consists of task name and path name. A dialog box
opens for specifying the exporting reference frame.

Export Path

See Exporting a path on page 73 for detailed descrip-
tion.

Import a path XML file into the current station as a
process path. A dialog box opens for specifying the
importing reference frame, tool, workobject, module,
and path name.

Import Path

See Importing a path on page 74 for detailed descrip-
tion.

With a check mark to indicate that the selected path
is visible.

Visible

Not available on an open path.

Delete the selected path. Not avail-able on an open
path.

Delete

Rename the selected path. Not available on an open
path.

Rename

Closes an open path, removing it from the path view.
Only available on an open path.

Close
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When a 3D path is created, a path with the path name would be displayed under
the path node. Menu of the 3D path is:

DescriptionMenu

Edit the Path section. For detailed description of the Path Sec-
tion, please see Create Path Section on page 78.

Edit

Delete the path.Delete

Setting of the path.Setting

Creating process paths
There are three ways to create process paths:

• Right-click a part program node and click Create Process Path.
• Click a part program node or a process path node, and click Process Path

in the Create group of the Cutting ribbon-tab.
• Add paths to the path list from the Create Part Program dialog box.

Exporting a path
To export a path into an XML file, follow these steps:

1 In the Cutting browser, right-click a path, and click Export Path. A dialog box
opens. Specify the name of the file and the directory to store.
The default name of the file is "Path_"+task name+"_"+path name.
The default directory is under "/My Documents/RobotStudio/Stations".

xx1300001206

2 Click Save and the Export Path dialog box opens.
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3 Complete the dialog box and click OK. The XML file will be saved.

xx1300001207

DescriptionObject

Describes the name of the path, the station, and the task. Read-
only.

Description

The directory where the file is stored. Read-only.Path

The name of the saved file.File Name

Select a reference that the path targets in the path are related
to. This affects the position and rotation values of these targets.
The references can be World Coordinate, User Coordinate
System, robot base coordinate, or work object coordinate.

Reference Frame

The included paths to be exported are listed here. Besides the
selected path, service paths are also listed, in case you want
to export service procedures together with the selected path.
Check the service procedures that you want to export together.

Included Path

Importing a path
To import a path XML file into the station, follow these steps:

1 In Cutting browser, right-click a path, and select Import Path. A dialog box
opens.
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Specify a path file to import and click OK. A message box opens telling if a
wrong type of XML file is selected.

xx1500000722
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2 Click Open. The Import Path dialog box opens.

xx1300001209

DescriptionObject

Describes the name of the part, the station, and the task. Read-
only.

Description

Reference used when the part program is exported. Read-only.ExportedWithRefer-
ence Frame

A reference to import part program. This affects the position
and rotation values of these targets. The references can be
World Coordinate, User Coordinate System, robot base coordin-
ate, or work object coordinate.

Import Reference
Frame

Select the tool for the part program. If left blank, the tool from
the file will be used.

Tool

Select workobjects for targets in the part program. If left blank,
the workobject from the file will be used.

Work Object

The synchronized RAPID module of the part programModule Name

The name of the imported part.Path Name
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3 Complete the dialog box and click OK. A new path will be imported.

Note

The rules about creating new data are the same as described in Importing
a Part program on page 68.
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5.4.4 Create Path Section

Overview
To add 3D free form cuts to a path, click Path Section on the Create ribbon tab.
The Create Path From Edge interface would show up.

Create Path From Edge interface (the first page)
Following is the first page of the Create Path From Edge interface:

xx1300001247

DescriptionObject

Show the selected continuous adjacent edges selected from the
CAD model.

Chaining Edges

The default edge selection method is manual selection.
After some edges are manually selected, If there are tangent edges
after the selected edges, the Tangent selectionmethod can be active.
Tangent edges afterward would be automatically selected if the
Tangent button is clicked. Users can use the Loop selectionmethod
by click the Loop button and select a continuous face group contain-
ing the former selected edges.

Delete the last selected cutting edge.

Continues on next page
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DescriptionObject

Delete all the selected cutting edges.

Click this button, the Path Endpoints Setting interface would show
up to set the start position and end position on the first and last
cutting edges.

xx1300001252

Reverse the edges items in the chaining edges.

Automatic tangent edge selection method. If users click this button
after at least one cutting edge has been selected, RS Cutting
PowerPac would automatically calculate followed tangent edges in
the cutting direction until a non-tangent edge is met. This function
is available only when there are tangent edges following the first
manually selected edges in the cutting direction.

Continues on next page
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DescriptionObject

Automatic loop selection method. This method is used to select
edges that form a loop. Click this button, the following interface
would show up:

xx1300001256

Select faces that constitute a continuous region with Face 1 which
contains the first manually selected edges and clickOK. Loop edges
would be automatically selected.
If faces selected can no constitute a continuous region with Face
1, the following message would prompt out:

xx1300001257

When this item is checked, gaps shorter than the minimum linear
distance in manually selected edges are acceptable. Only applicable
for manually edge selection method.

Skip Gap

For detailed description, please see Reference Coordinate System
(RCS) on page 16.

Reference Coordin-
ate System (RCS)

Specify the rotation angle around X axis.Rotation around X

Indicate whether inverting the current normal of the cutting surface.Invert Normal

Parameters as minimum andmaximum distances, maximum radius
etc. for different approximation types.

Approximation Para-
meters

Apply the linear approximation parameters on current selected
edges.

Linear

Apply the circular approximation parameters on current selected
edges.

Circular

If one edge failed to apply the circular approximation, it would
automatically change to apply the linear approximation.

Apply the constant length approximation on current selected edges.Constant

Specify the maximum length for linear approximation.Max Lin Dist (mm)
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DescriptionObject

Specify the edge length of the corner for linear approximation.Corner Appr Dist
(mm) This value should be greater than the value of "Min Dist", otherwise

it has no effect on approximation.
Therefore if the user don't want insert any corner into the linear
paths, this value can be set with 0.

Specify the minimum length for linear approximation.Min Dist (mm)
If one linear path's length is shorter than this specified value, this
linear path would be eliminated in the resultant paths.
Instead, a new linear path, which starts from the end position of the
previous valid path and ends to the start position of the next valid
path, will be inserted into the path list.

Specify the maximum length for circular approximation.Max Circ Dist (mm)

Specify the maximum radius for circular approximation.Max Radius (mm)

Specify the maximum chord value for circular approximation.Chord Dev (mm)
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Create Path From Edge interface (the second page)

Introduction
The second page of free form cutting selection interface:

xx1300001248

DescriptionObject

Lead parameters about the lead in and lead out path of the cutting
head before and after the cutting.

Lead Data

If selected, the new cutting will include an approach target before
Process Start point.

Lead In

If selected, the new cutting will include a depart target after Process
End point.

Lead Out

There are two types of leaddata: Linear and circular.Type

In the leadout phase of cutting, the overlap distance between the
start point of leadout (that is, the exit point) and the entry point. Only
applicable in closed loop shape cutting.

Overlap (mm)
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DescriptionObject

Select the direction of the material side. When you select Display,
an arrow indicating the direction of the material side is displayed. It
is useful for creating or editing the path.

Material Side

Select the process template from the drop down list and click the i
button, an interface displaying some manually input process para-
meters of the process template, such as voltage, current etc. would
show up.

Process Template

Used to offset the position of targets, approach point and depart
point. If Use Target Settings is ticked, the offset settings would be
used.

Use Target Settings

The offset distance of the process targets with their RCS.Offset X,Y,Z (mm)

The offset distance of the approach points with their RCS.Modify Approach,
Offset X,Y,Z (mm)

The offset distance of the departure points with their RCS.Modify Depart.Offset
X,Y,Z(mm)

Lead Data Linear

xx1300001297

DescriptionObject

The angle of the linear lead in/out path relative to the tangent line of the
cutting path at the entry/exit point.

Angle (Deg)

The vertical distance from the start/end point of the linear lead in/out
path to the tangent line of the cutting path at the entry/exit point.

Distance (mm)

Lead Data Circular

xx1300001298

DescriptionObject

The radius of the circular between the start/end point and the entry/exit
point and which is also tangent to the tangent line of the cutting path at
the entry/exit point.

Radius (mm)

The distance of the start/end point on the leadin/leadout path to the
tangent line of the cutting path at the entry/exit point.

Distance (mm)

Continues on next page
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Create Path From Edge interface (the third page)

Introduction
The third page of free form cutting selection interface:

xx1300001258

DescriptionObject

The tool status of angle.Tool Angle (deg)

The work angle, push/drag angle, and tool spin angle of the tool, in rela-
tion to its RCS.

Angle x,y,z (deg)

The item to choose the tool angle type along the cutting path. Here three
methods to calculate the tool angle are listed:

• Follow path.When this type is selected, direction of the X axis of
TCP is the same with the RCS’s X axis of the edge. Direction of
the Y and Z axes are contrary to the RCS’s of Y and Z axes.

• Fixed tool rotation/orientation. When this type is selected, tool
rotation/orientation is fixed as the first target in the path. For de-
tailed description, see Fixed tool rotation/orientation on page 85.

• Spherical interpolation of tool rotation. For detailed description,
see Spherical interpolation of tool rotation on page 85.

Type

When selected, a simulated TCP would be displayed to indicate the
modified tool angle.

Display

The name of the new cutting.Cutting name

Select tool of the cutting.Tool

Select work object for the targets of the new cutting.Work Object

Continues on next page
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DescriptionObject

Indicate whether using target settings.Use Target Set-
tings

Fixed tool rotation/orientation
When the tool angel type is Fix tool orientation, the following interface can be seen:

xx1300001259

Description/IllustrationObject

When this option is selected, the X axis direction of the TCP along the
cutting path would be fixed as the same with the first point while the Z
axis direction of the TCP keeping unchanged.

Copy tool rota-
tion of the first
point

When this option is selected, the direction of the TCP along the cutting
path would be fixed as the same with the TCP of the first point on the
cutting path.

Copy tool orienta-
tion of the first
point

Spherical interpolation of tool rotation
Spherical interpolation of Z is an another method to calculate the angle of TCP.
When Spherical interpolation of tool rotation is selected, the following interface
can be seen:

xx1300001260

Description/IllustrationObject

When this option is selected, the Z axis of the tool orientation would rotate
during the tool’s moving along the cutting path.

With ZAxisRota-
tion

.When this option is selected, the Z axis of the tool orientation would not
rotate during the tool’s moving along the cutting path

No Z Axis Rota-
tion
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5.4.5 Create 2D Shape

Creating Cuts
To add 2D shape cuts to a path, click 2D Shape Data.
The Create Shape Data From Edges window is displayed.
Following is the first page:

xx1300001204

DescriptionObject

Show the selected continuous adjacent edges from the CADmodel.List Box (Marked
with 1)

Remove the last edge in the list box.Remove Last

Clear all the selected edges.Clear

Reverse the edges items in the list box.Reverse Path

The reference coordination system based onwhich the cutting frame
would be created.

Reference Coordina-
tion System

Position of the TCP. Click the < sign after the position fields would
active the Center button. Click the Center button, TCP would auto-
matically go to the center of the 2D shape.

Position

Continues on next page
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DescriptionObject

X vector of the path frame.x vector
Click the < sign after the x vector fields to active the x vector modi-
fication function, then click in the 3D graphic view window to select
another x vector. Click the Modify button to modify the position of
the TCP. Click Invert button in the interface can invert the direction
of the x vector.

Displays the path frame.Show Path Frame

Displays the TCP.Show Tool

Offset the cutting path in X, Y, Z directions.Path Offset (mm)

Parameters as minimum andmaximum distances, maximum radius
etc. for different approximation types.

Approximation Para-
meters

Specify the maximum length for linear approximation.Max Lin Dist (mm)

Specify the maximum length for circular approximation.Max Circ Dist (mm)

Specify the edge length of the corner for linear approximation.Corner Appr Dist
(mm) This value should be greater than the value of "Min Dist", otherwise

it has no effect on approximation.
Therefore if the user don't want insert any corner into the linear
paths, this value can be set with 0.

Specify the maximum radius for circular approximation.Max Radius (mm)

Specify the minimum length for linear approximation.Min Dist (mm)
If one linear path's length is shorter than this specified value, this
linear path would be eliminated in the resultant paths.
Instead, a new linear path, which starts from the end position of the
previous valid path and ends to the start position of the next valid
path, will be inserted into the path list.

Specify the maximum chord value for circular approximation.Chord Dev (mm)

Apply the linear approximation on current selected edges.Linear

Apply the circular approximation on current selected edges.Circular
If one edge failed to apply the circular approximation, it would
automatically change to apply the linear approximation.

Apply the constant length approximation on current selected edges.Constant
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Following is the second page:

xx1300001205

DescriptionObject

The drop down list to select the start point of the cutting.Entry Point

When selected, the entry point would be displayed in the cutting
path.

Show Entry-Point

When selected, the nearest point to the TCP would be picked as the
entry point of the cutting.

Pick Nearest Point

Lead parameters about the lead in and lead out path of the cutting
head before and after the cutting.

Lead Data

If selected, the new cutting will include an approach target before
Process Start point.

Lead In

CW or iCW. Indicate the cutting direction is clockwise or anticlock-
wise.

Cut Direction

When click Create Cut, a cutting data file would be prompt to be
saved and a cutting instruction would be added in the path view
window.

Create Cut

When click Create Data File, only a cutting data file would be prompt
to be saved.

Create Data File

The 2D shape cuts also can be added in the Path view window. See 2D shape
instructions on page108 for the detailed description of how to add cuts to process
paths in the Path view window.
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5.5 Other edit for task

Overview
You can access the shortcut menus for the task node (top node) in the Cutting
browser by right-clicking the task node.

Shortcut menus from the task node

DescriptionDialog Box ElementsMenu

Allows you to specify the following properties for the
selected task:

xx1300001179

Properties

From the options selected in the virtual controller, the
system determines the application suitable to the robot
type. If the robot is for laser cutting, an appropriate
move and action instruction set will be imported to the
station.

Application

This optional property adds a procedure before the
first cutting of every part program. This is usually the
starting point for the first cutting, ensuring that the
robot can actually move to the first instruction in the
first cutting.

Default Move to
Home Procedure

This optional property puts all workobjects and
tooldata in the specified module when synchronizing
with the virtual controller. You can map it to a specific
RAPID module in the virtual controller.

Calibration Data
Module

This mandatory property puts all process data in the
specified module when synchronizing with the virtual
controller. You can map it to a specific RAPID module
in the virtual controller.

ProcessDataModule

This optional property sets the color used to highlight
open paths in the Cutting browser and the path view.

Default Path Color

Refreshes the browser to reflect changes in the path
view.

Refresh

Continues on next page
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DescriptionDialog Box ElementsMenu

Imports predefined action instructions.Import Ac-
tion Instruc-
tion

Imports predefined move instruction descriptions.Import
Move In-
struction
Description

Imports predefined move instructions.Import
Move In-
struction

Synchronizes the entire task to the virtual controller.

Note

Since the Synchronize to Virtual Controller is avail-
able from the shortcut menu in Cutting PowerPac, the
Synchronize to virtual controller function in RobotStu-
dio’s Offline tab will be disabled.

Synchronize
to Virtual
Controller

Import Action Instruction/Move Instruction/Move Instruction Description
Some default move instructions are always available in the controller after the
RobotStudio and Cutting PowerPac are installed.
To be able to use instructions other than default, it is necessary to tell RobotStudio
how these instructions should be handled.
Follow these steps to import instructions:

1 Right-click a task node and click Import Action Instruction or Import Move
Instruction Description, or Import Move Instruction. A dialog box opens.

2 In Look in, browse to the location where you stored the instruction files
(*.xml).

3 Select the desired file and clickOpen to import the selected file to the current
task.

A default set of action instructions and move instruction can be automatically
imported when you open a system for the first time:

xx1300001180

Click Yes to automatically load the templates files. Click No to deny automatic
loading. Click Cancel to skip automatic loading this time.
Default directories are:

• /HOME/RS of the system folder. This will be ignored if not present.
• /MyDocument/RobotStudio/ProcessPac/

See Operating manual - RobotStudio for the definition of Action Instruction, Move
Instruction, and Move Instruction Description.
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6 Path view
6.1 Overview

Path view window
The Path view window displays the targets in a path by representing them with
Instruction icons on page 92. Path creation, modification, configuration and
simulation functions also are included in this window.
The large arrow head indicates the start of a path. When a program contains several
paths, the first instruction in the path view is the last instruction of the preceding
path. This enables you to verify that the robot can bridge the paths.
The path view holds Path View toolbar general introduction on page 96, which has
menus and buttons for the most frequently used commands. You can use the
Create menu to add or insert instructions and the Modify menu to manipulate
targets and axes. Users can modify individual targets or the entire path.
The path view also contains a Shortcut menu on page 95 and a number of
Multi-Selection Operations on page 121 to modify multiple targets.

xx1300001176

• Check reachability and modify robot configuration. For detailed information,
see Configuration Menu on page 133.

• Create 2D and 3D cutting paths. For detailed information, see Create
instructions on page 98 and 2D shape instructions on page 108.

• Modify an individual cutting instruction/target or grouped instructions/targets
in a path. For detailed information, see Modify instructions on page 115.

• Cutting process simulation and its setting. For detailed information, see Path
View toolbar on page 96.

All the functions are set to create cuttings and help the robot can reach efficiently
all cutting targets in the cutting path.

Improve the reachability of cutting
Following are general methods to improve the reachability of the cutting:

• Set ConfL or ConfJ to Off for enabling the robot to use new configurations
for reaching the target.

• Change the orientation of the target.
• Change the position of either the robot or the work piece.
• Use a system with a track external axis for increasing the robot’s range.
• Use a systemwith a positioner external axis for enabling different work piece

positions for different targets.
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6.2 Instruction icons in the path

Overview
Instruction icons displays the type (shape), motion (arrow) and status (color) of
each target. The lower level targets represents process sections, such as cutting
paths and search sequences, while the upper level targets represents air move
sections, which typically connect process sections.

Instruction icons
The following table describes the icon shapes:

DescriptionIcon

Target

Target with collision error

Process start target

The following table describes the arrows:

DescriptionIcon

Linear move

Joint move

Absolute joint move

Circular move

The following table describes the color coding. The goal is to turn all the status
fields green before synchronizing the paths to the virtual controller.

DescriptionIcon

White = unknown status

Green = target verified

Yellow = solution found, but not verified

Red = no solution, or target out of reach

Blue = non-motion instruction

Continues on next page
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The following table describes examples of the above:

DescriptionIcon

Linear move, process start target, solution found but not verified

Joint move, target verified

Circular move, target verified, with collision error

Circular move, target verified, with collision error

Joint move, target verified, with collision error

Linear move, target verified, with collision error

Linear move, process start target, solution verified, with collision error

Circular move, no solution or out of reach

Linear move, unknown status

The following table describes the instruction levels:

InstructionInstruction typeLevel

MoveL, MoveJAirUpper

CutLStart, CutL, CutC, CutLEnd, CutCEnd,
Search_1D,

ProcessLower

The following table describes the non-motion instructions:

DescriptionIcon

WaitSyncTask

SyncMoveOn

SyncMoveOff

Continues on next page
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DescriptionIcon

Miscellaneous RAPID

Example

PROC My Path

MoveJ

SearchL

SearchL

MoveL

MoveL

WaitSyncTask

MoveJ

CutLStart

CutL

CutC

CutCEnd

MoveL

MoveJ

SyncMoveOn

CutLStart

CutL

SetDO

CutL

CutLEnd

SyncMoveOff

MoveL

MoveJ

ENDPROC
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6.3 View and edit in the path view toolbar

6.3.1 Shortcut menu

Overview
The table describes the commands of the path view shortcut menu.

DescriptionObject

See Create instructions on page 98.Create

See 2D shape instructions on page 108.Shapes

See Modify instructions on page 115.Modify

See Check Reach on page 133.Check Reach

See Path View toolbar general introduction on page 96.Jump To

See Path View toolbar general introduction on page 96.Move To

Displays instruction, the path angle and tool angle for the selec-
ted item.

Show Item Info

Sets the target referenced in the instruction as User Coordinate
System.

Set Target Reference as
UCS

Deletes the selected item.Delete

Converts a MoveJ instruction to a MoveL instruction.Modify/Convert to Linear
Move

Converts a MoveL instruction to a MoveJ instruction.Modify/Convert to Joint
Move

Converts an approach or depart instruction to an air instruction,
and disconnects it from the first or last target, respectively, in
a cutting path.

Modify/Convert to Air

Converts an air instruction to an approach or depart instruction,
and connects it to the first or last target, respectively, in a seam.

Modify/Convert to Ap-
proach

Export one or more process sections into XML path file. Only
available on Process Start target, or range selections with even
pairs of Process Start and Process End targets.

Export ProcessSection(s)

Import path XML path into station, as one or more new cutting
in the path. Only available on non-process targets.

Import ProcessSection(s)

Switch to select the corresponding instructions in RobotStudio
environment when you select a range of icons in path view. You
may see the effect by checking theModify ribbon-tab of Robot-
Studio.

Select Instructions
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6.3.2 Path View toolbar general introduction

Overview
The path view toolbar has buttons for the most frequently used commands.

Path View toolbar

DescriptionIcon

The Set View Center button sets the view center automatically
to the selected target in the path view or the active TCP (if no
target is selected).

This menu contains the following commands:
• Create Free Form Cutting on page 99
• Create CutL/C instruction on page 101
• Create Air instruction on page 103
• Create ABS joint target on page 105
• Create an Action instruction on page 106
• Create Procedure Call on page 107

The Create menu

This menu contains the following commands:
• Cut Circle instruction on page 109
• Cut Wrist Circle instruction on page 110
• Cut Rectangle instruction on page 111
• Cut Slot instruction on page 112
• Cut Hexagon instruction on page 113
• Cut 2D shape instruction on page 114.

The Shapes menu

This menu contains the following commands:
• Modify instruction on page 115.
• Modify target on page 117
• Modify Jointtarget/External Axes on page 119
• Modify Reference Vector on page 120
• Modify Selected Targets on page 121

The Modify menu

This menu contains the following commands:
• Check Reach on page 133.
• Set Configuration on page 134.

The Configuration menu

• The Jump to Target button jumps the robot with active
TCP to the selected target. It gives you a chance to view
cutting head angles and detect possible collisions with
the robot.

• A successful result turns the target yellow and moves
the robot one discrete step towards the target.

• An unsuccessful result turns the target red and leaves
the robot in its current position.

Continues on next page
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DescriptionIcon
• TheMove to Target buttonmoves the robot to the selec-

ted target from the previous target in the target list,
checks for reach and sets the robot configuration. You
can also select a range of targets and move the robot in
sequential order down the target list.

• A successful result turns the target green andmoves the
robot continuously towards the target.

• An unsuccessful result turns the target red and leaves
the robot in its current position.

Note

The virtual controller is not running when executing this com-
mand.

The Execute Move Instruction button executes the path asso-
ciated with the selected target. It is only effective on the target
generated by commands in the Shapes menu.

The Simulate button synchronizes the opened paths to the
virtual controller and executes the paths in the virtual controller.

The menu contains the following options related with Simulate:
• Enable Log
• Save As View
• Auto View-Center On

Check or clear the check boxes to enable or disable the options.

The Options menu

See The Options Menu on page 138 for more information.

The Speed Control list applies only to Jump to and Move to.
Simulation speed is determined by the RAPID program.

The index and name of the active object.
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6.3.3 Create instructions

6.3.3.1 Overview

Overview
This menu contains the following commands:

• Create Free Form Cutting on page 99.
• Create CutL/C instruction on page 101.
• Create Air instruction on page 103.
• Create ABS joint target on page 105.
• Create an Action instruction on page 106.
• Create Procedure Call on page 107

Note

The contents of the Create menu will change depending on selected target. The
Create dialog boxes can not exist together with other dialog boxes brought from
the path view. They will close other dialog boxes automatically, and vice versa.
Thus, make sure that changes in dialog boxes have been applied before a create
dialog is opened.
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6.3.3.2 Create Free Form Cutting

Overview
This command creates a continuous path that includes the following targets:

• Approach Move (optional)
• Process start
• Process Via
• Process End
• Depart Move (optional)

This command is available after a path or the last instruction in a free from cutting
path has been selected.

Creating a Free Form Cutting path procedure
To create a free form cutting path, follow these steps:

1 Click Path Section in the Create cutting ribbon tab or click Create -> Free
Form Cutting in the path view window. The Create Path From Edge window
is displayed.

xx1400002296

Continues on next page
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2 In the Create Path From Edge window, select the required fields in the I, II,
and III tabs and click the Create Instructions button.

xx1400002297

The free form cutting path is created. For more details, see Create Path
Section on page 78.

Related Information
Path View toolbar general introduction on page 96.
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6.3.3.3 Create CutL/C instruction

Overview
This command, which is available only when a process instruction is selected,
adds cut instructions to a free form path.

Creating a CutL/C instruction
To create a CutL/C instruction, follow these steps:

1 In the Path View, select the process start target and then in theCreatemenu,
click CutL/C Instruction.

2 In the graphics window, click in the middle of the free form path to add a new
cut.

xx1300001261

3 Optionally, select the Auto OK check box to automatically create the cut
instruction when valid input has been entered, and then click OK.
A new target is displayed in the graphics window, and an instruction icon is
added to the path view.

xx1300001262

Continues on next page
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Note

To make a smooth movement from the previous target to the new target,
the default angle of the target is the same as the previous one.

Related Information
Path View toolbar general introduction on page 96.
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6.3.3.4 Create Air instruction

Overview
Air instructions can be added to a path.

Creating an Air instruction
To create an air instruction, follow these steps:

1 In the Path View, select the last target.
2 In the Create menu, click Create Air Instruction.
3 In the graphics window, move the robot’s TCP to the desired position. In the

dialog box, click Present. This will read the current position of the active tool
into the Data Input area.

xx1300001263

4 In the dialog box, clickOK. A new target is displayed in the graphics window,
and an instruction icon is added to the path view.
If the Auto OK check box is selected, the air instruction is automatically
created when a valid input has been entered.

xx1300001264
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Related Information
Path View toolbar general introduction on page 96.
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6.3.3.5 Create ABS joint target

Overview
Absolute joint instructions can be added to a path.

Creating a Jointtarget
To create a jointtarget, follow these steps:

1 In the path view, select the last target.
2 In the Create menu, click Absolute Joint Instruction.

xx1300001265

3 Jog the robot to an arbitrary position and click OK.
A new jointtarget is displayed in the graphics window, and an instruction
icon is added to the path view.

xx1300001266

Related Information
Path View toolbar general introduction on page 96.
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6.3.3.6 Create an Action instruction

Overview
Absolute joint instructions can be added to a path.

Creating an Action Instruction
To create an action instruction, follow these steps:

1 In the path view, select the last target.
2 In the Create menu, click Action Instruction.

The Create Action Instruction window is displayed.

xx1400002299

3 Select an instruction from the Instruction Templates list.
For more information on the various instructions, refer Technical reference
manual - RAPID Instructions, Functions and Data types.

4 Select a mechanical unit from the Instruction Arguments list.
5 Click OK.

A blue instruction icon is added to the path view.

Related Information
Path View toolbar general introduction on page 96.
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6.3.3.7 Create Procedure Call

Overview
Procedure calls can be added to a path.

Creating Procedure Call
To create a Procedure Call, follow these steps:

1 In Path View, select the last target.
2 In the Create menu, click Procedure Call.

The Create Procedure Call window is displayed.

xx1400002298

3 Select a path procedure from the Path Procedure Name list.
4 Click OK.

A blue instruction icon is added to the path view.

Related Information
Path View toolbar general introduction on page 96.
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6.3.4 2D shape instructions

6.3.4.1 Common items used in Shape menu

Overview
The commands in the Shapesmenu are used to create cutting instructions based
on specified geometry shapes. The geometry shapes can be defined by actions
on the CAD model in the geometry window. All the instructions created by this
menu are applied on the 2D cutting path.
Following are the common items used in the windows corresponding to each
command in the Shapes menu.

DescriptionObject

Specifies the process template for the new cutting instruction.Active Process

Specifies the tool object for the new cutting instruction.Tool

Specifies the work object for the new cutting instruction.Work Object

Specifies the reference frame for the new cutting instruction.Reference

If selected this option automatically accomplish the creation after the
geometry feature is specified.

Auto OK

Specifies the current position as the selected input point.Present
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6.3.4.2 Cut Circle instruction

The Cut Circle instruction is used for cutting a circle on the desired postion by
defining the points along the circumference.
The three points, Point 1, Point 2 and Point 3, define the circle feature in the dialog
box.

xx1300001267
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6.3.4.3 Cut Wrist Circle instruction

The Cut Wrist Circle instruction is used for cutting a circle on the desired
postion by defining the circumference.
TheCutWrist Circle Instructionwindow is very similar to theCut Circle Instruction
window. The only difference is the presence of the Active Process list in the
window.

xx1300001268
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6.3.4.4 Cut Rectangle instruction

The Cut Rectangle instruction is used for cutting a rectangle on the desired
postion by defining the vertices.
The four vertices, point1, point2, point3 and point4, define the dimensions of the
rectangle in the window.

xx1300001269
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6.3.4.5 Cut Slot instruction

The Cut Slot instruction is used for cutting a slot on the desired postion by
defining the boundaries.
The three points, Point 1, Point 2 and Point 3, define the slot feature in the window.

xx1300001270
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6.3.4.6 Cut Hexagon instruction

The Cut Hexagon instruction is used for cutting a Hexagon on the desired postion
by defining the vertices.
The three points, Point 1, Point 2 and Point 3, define the hexagon feature in the
window.

xx1300001271
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6.3.4.7 Cut 2D shape instruction

Create Shape Data From Edges Dialog Box
To create a 2D shape instruction from the Path view toolbar, you must first specify
a corresponding shape data file which is created by clicking the 2D Shape Data
button in the Create group in the Cutting tab.
For more details about create 2D shape data, see Create 2D Shape on page 86.

Create Cut… Dialog Box
The Cut Hexagon instruction is used for cutting complex shapes on the surface
by defining the boundaries.
Click the Shapes list and select Cut 2D shape Instruction.... The Create Cut...
window is displayed.

xx1300001272

DescriptionObject

Specify the shape data file (.cad file) created by the Create
Shape Data From Edges dialog box.

Note

The shape data must be located in the default folder "Controller
System Path"\\HOME\\CwCadShapes.

Shape Data

Specify the reference point for the shape data. This point is
corresponding to the Location in the first page of the Create
Shape Data From Edges dialog box.

Point 1
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6.3.5 Modify instructions

6.3.5.1 Modify instruction

Overview
Most instructions have arguments that specify how the instruction must be
performed. For example, the arguments of the LsCutCricleJ instruction specify
the circle geometry feature with which the robot moves along the circle path. In
the Modify Instruction dialog box, you can display and change these arguments.

The Modify Instruction Dialog Box

xx1300001273

Related Information
Path View toolbar general introduction on page 96.
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6.3.5.2 Modify multiple instructions

xx1400002783

The Modify Instruction (Multiple Selection) window allows you to change the
instructions and the corresponding common parameter values when multiple
targets are selected from path view.
Only similar instructions are allowed to be edited together since they have the
same arguments which can be set to one value.
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6.3.5.3 Modify target

The Modify Target Dialog Box
The Modify Target dialog box is used to edit target positions and orientations.

xx1300001274

DescriptionObject

The coordinate system of the target reference. All available frames in the
station are listed. It affects the values shown for RCS's position and rotation.

Reference

The position and rotation of the RCS.TargetRefer-
ence (RCS) Highlight the arrow head on the right to select a new position in graphic inter-

face, or manually enter values to modify.

Note

Since Approach/Depart targets' RCS align with Start/End target, their RCS
are not directly modifiable.
For rotation of process targets, such as Start, Via, and End targets, only ro-
tating around X axis is allowed. For other targets, rotation around x, y, and
z axis are all available.

Continues on next page
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DescriptionObject

If selected, modifications made on RCS will also affect the target in world
frame, and the offset and angle of the target in its RCS keeps unchanged.

Link to tar-
get

Normally the target is set to be linked with it's RCS.

The offset and angle values are relative to the target reference. For information
on tool angles.

Target

Related Information
Path View toolbar general introduction on page 96.
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6.3.5.4 Modify Jointtarget/External Axes

Overview
This dialog box is used to modify the jointtarget or external axis values of a selected
target. Jointtargets are used in instructions such as MoveAbsJ and MoveExtJ.

Modifying a Jointtarget or External Axes
To modify a jointtarget or external axis, follow these steps:

1 In the Modify menu, click Jointtarget / External Axes.
2 Click Present to obtain the external axis values of the active robot, and then

move the slide bars to jog the robot.
3 Click Apply.

Related Information
Path View toolbar general introduction on page 96.
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6.3.5.5 Modify Reference Vector

Overview
This dialog box is used to modify the reference vector of a selected cutting
instructions based on the geometry feature.

The Modify Reference Vector Dialog Box

xx1300001275

DescriptionLabel

Select a vector for editing (X vector or Z vector).1

Set or modify the value of the selected vector.2

120 Operating manual - Cutting PowerPac
3HAC043509-001 Revision: H

© Copyright 2012-2019 ABB. All rights reserved.

6 Path view
6.3.5.5 Modify Reference Vector



6.3.5.6 Multi-Selection Operations

Overview
Multiple targets may be selected in the path view by clicking one target, pressing
SHIFT and then clicking another target. All targets in between will also be
highlighted grey.
Depending on the targets selected, the following additional operations may be
available from the shortcut menu.

Modify Selected Targets
This command shows a dialog box containing several useful function options which
can be respectively performed on multi-selected free form path targets.

xx1300001276
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DescriptionObjectGroup

If this option is enabled, the group Current
Selected Target, representing the first click-
ing target in the selected target list, is shown
up.

Copy X axis of current se-
lected (Z axis fixed)

Operations

For the detail description of this option, see
the option Spin X to Selected in Optimize
selected target on page 126.

If this option is enabled, the group Current
Selected Target is shown up.

Copy orientation of current
selected

For the detail description of this option, see
the option Copy Rotation from Selected in
Optimize selected target on page 126.

If this option is enabled, the group Current
Selected Target is shown up.

Modify offset/angle in RCS

For the detail description of this option, see
Target Offset/Angle on Selection on page124.

If this option is enabled, two groups First
Selected Motion Target and Last Selected
Motions Target, representing respectively the
first and last motion target in the selected
target list, are shown up.

Interpolation Orientation
(Z axis fixed)

For the detail description of this option, see
the option Interpolate Orientation ofOptimize
selected target on page 126.

If this option is enabled, two groups First
Selected Motion Target and Last Selected
Motions Target are shown up.

Interpolate Offset in RCS

For the detail description of this option, see
the option Interpolate Targets Offset of Op-
timize selected target on page 126.

Specify the offset of the target in RCS.OffsetCurrent Selected
Target /First Se-
lected Motion
Target /Last Se-
lected Motion
Target

Specify the angle of axis X, Y and Z respect-
ively in RCS.

Angle x.y.z

Target Reference Position on Selection

xx1300001277
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The following table describes the elements of the dialog box.

DescriptionObject

The coordinate system of the target reference. All available frames in
the system are listed.

Reference

Select to perform a relative move of the target reference.Relative

Select to move the selected targets together with RCS.Link to target

Enter the absolute position or relative move of the target reference. If
you want to move the target reference in just one direction, clear the
check boxes of the other axes.

Position

Target Reference Orientation on Selection

xx1300001278

This command applies only to process instructions.
The following table describes the elements of the dialog box.

DescriptionObject

The coordinate system of the target reference. All available frames
in the system are listed.

Reference

Select to perform a relative reorientation of the approach vector.Relative

Select to rotate the selected targets.Link to target

The arrowhead points to the current values of the base plate normal.
ClickModify to enter a new vector or invert the current one. Altern-
atively, click the arrowhead to turn it black, and then click in the
graphics window on the surface that will constitute the new base
plate.

Modify Base Plate
Normal

Continues on next page
Operating manual - Cutting PowerPac 123
3HAC043509-001 Revision: H

© Copyright 2012-2019 ABB. All rights reserved.

6 Path view
6.3.5.6 Multi-Selection Operations

Continued



Target Offset/Angle on Selection

xx1300001279

This command offsets or rotates selected targets of process instructions a given
distance or angle. This offset or angle is in relation to the target references
coordinate system. If Relative is selected, the offset or angle will be in relation to
the target itself. Clear the offset or angle directions in the tree nodes on the left
side that have no bearing on the operation.

External Axes Values on Selection

xx1300001280

This command sets the external axis values on all selected targets. If Relative is
selected, the given value will be in relation to the current external axis values
defined for each target.
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Convert to MultiMove Section

xx1300001281

xx1300001282

It is possible to enter special commands for motion synchronization in the path
view. These commands are represented by blue instruction icons and letter flags.
Each letter represents a Sync ID, and two identical letters form a pair marking a
synchronized MultiMove section.
Select all instructions to be included in the MultiMove section. From the context
menu, select Modify/Convert to MultiMove Section. A dialog appears asking the
user to define a Sync ID and a Task List. If there are no Sync IDs or Task Lists
present in the station, you can create new by selecting Create new from the list.
The necessary data will then be created automatically. When creating a new Task
List, you will also be prompted to select the tasks to be included in the list.
For more information, see Application manual - MultiMove.
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Stick-Out

xx1300001283

DescriptionObject

This commandmodifies the position of the target offset as a function
of stick-out. The value of the stick-out is based on the defined tool
properties. It affects the tool position along its z axis.

Stick-Out

This value modifies the position of the target offset along its y axis.Offset

Optimize selected target

xx1300001284

DescriptionOption

Spin the X axis of the targets towards the robot base.Spin X Towards Robot Base

Continues on next page
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DescriptionOption

This function can be used to orient a row of targets so
the target x axes point in the same direction. The
function will spin all marked targets around the z axes
until the target x axes match the selected target x axis
as close as possible.

Spin X to Selected

Before using this function, the status is illustrated in
the following picture.

xx1300001285

After using this function, the status is illustrated in the
following picture.

xx1300001286
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DescriptionOption

This function copies the orientation of the selected
target to all other marked targets. Depending on the
type of target, only the appropriate part of the orienta-
tion is copied. For an air target, it is a complete copy.
For a process target, only the orientation of the tool-x
axis is copied. For a search target, the reference frame
is aligned with the selected target z axis and the search
target x axis is aligned with the selected x axis.

Copy Rotation from Selected

Before using this function, the status is illustrated in
the following picture.

xx1300001287

After using this function, the status is illustrated in the
following picture.
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DescriptionOption

xx1300001288

Interpolate orientations of targets based on the selec-
ted coordinates.

• Interpolate inWorld (Z axis fixed): Set to inter-
polate the Z axis value of the Euler angles of
the targets, in relative to world frame (that is,
external axes, if exist, are moved to calculate
interpolation values).

• Interpolate in Object (Z axis fixed): Set to inter-
polate the Z axis of the Euler angles of the tar-
gets in object frame (work object), with Z axis
fixed.

• Interpolate in RCS (Al axes): Set to interpolate
the travel, work and spin angle of the targets in
each RCS.

• Interpolate in RCS (Z axis fixed): Set to inter-
polate the spin angle of the targets in each RCS,
with Z axis fixed.

xx1300001289

Interpolate Orientation

Interpolate offsets of targets based on the selected
coordinates.

Interpolate Targets Offset

Continues on next page
Operating manual - Cutting PowerPac 129
3HAC043509-001 Revision: H

© Copyright 2012-2019 ABB. All rights reserved.

6 Path view
6.3.5.6 Multi-Selection Operations

Continued



DescriptionOption

This command interpolates the external axes for a
select range based on themove distance between the
tool robot points. The points can be either in the same
path or in different open paths.

Interpolate External Axes

This command can be used to optimize air moves. The
function tries to interpolate the robot wrist axes from
the selected start target to the selected end target.
The interpolation of the joint values is based on the
move distance of the robot targets. All selected targets
must have a solution before the operation is executed.

Interpolate Robot Wrist Axes

Before using this function, the status is illustrated in
the following picture.

xx1300001290

After using this function, the status is illustrated in the
following picture.

xx1300001291
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DescriptionOption

Optimizes the spin angles of the selectedmotion items
by minimizing the value change of robot joint moves.

Minimize Axes Movement

It searches for a best target orientation by evaluating
multiple orientation values in the close range, based
step angle.
The weight value for each joint shows the importance
of each joint in the minimization.
Several checkings on joint moves can be enabled to
filter out invalid targets.

• Axes Weight: Weight for this axis during
searching axis.

• Test Step size: The step value of the angle to
search for best orientations of the target.

• Number of Tests: The maximum number of
steps to search for best orientations.

• Min Angle Axis 5: The minimum angle of axis
5 to keep during searching. Set to a value large
enough so that an orientation close to singular-
ity is not selected.

• Set Axis 2 Init value to 0: Set axis 2 to zero
during searching.

• Check Sign Axis 5 for Joint Move: Keep the
sign of axis 5 value during searching.

• Check Min Axis 5 Angle for Joint Move: Make
axis 5 minimum angle effective during search-
ing.

xx1300001292
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DescriptionOption

Set the Z axis of the targets towards the tool. This is
usually used in laser cutting.

• Min Angle (deg): Enter the minimum angle
between z axis of the target and the RCS during
pivoting. You may need this to keep the laser
tool from cutting perpendicularly onto the work
piece surface.

• Max Angle (deg): Enter the maximum angle
between z axis of the target and the RCS during
pivoting. Youmay need this to make the cutting
direction not too inclined towards work piece
surface.

• Align Target X to Tool X: Check to also set the
x axis of target to current x axis of the tool.

xx1300001293

Pivot Target From TCP to RCS

Click this button to apply your settings on the selected
targets.

The Apply button

Click this button to cancel your settings in this editor.The Cancel button

132 Operating manual - Cutting PowerPac
3HAC043509-001 Revision: H

© Copyright 2012-2019 ABB. All rights reserved.

6 Path view
6.3.5.6 Multi-Selection Operations
Continued



6.3.6 Configuration Menu

6.3.6.1 Check Reach

Overview
The Check Reach command verifies whether the robot can reach a target. A
successful result turns the color of the target as white or yellow. The white color
donotes there is no configuration assigned to the target and yellow color denotes
there is a configuration assigned to the target. An unsucessful result turns the
color to red.

Related information
Path View toolbar general introduction on page 96.
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6.3.6.2 Set Configuration

Overview
It is possible to attain the same target position and orientation in several different
ways, using different sets of axis angles. We call this the settings of different robot
configurations.
In Cutting PowerPac, robot configuration can be set for individual targets. The
system calculates a configuration based on your selections, after which values are
displayed.

The Set Configuration Dialog Box
This dialog box requires that you select three positions, one each for the robot
arm, wrist and tool, before clicking Apply.

xx1300001294
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The following table describes the elements of the dialog box:

DescriptionObject

The group is used to specify whether the robot wrist is in front of or
behind axis 1, and whether the elbow is up or down.

Arm

This group is used to specify whether axis 4 will be turned positive
or negative.

Wrist

This group is used to specify whether axis 6 will be turned positive
or negative. If neutral is selected, the configuration of axis 6 will be
determined by the arm and wrist selections.

Tool

This list displays the configuration and joint values for a selected
configuration, as well as alternatives.

New

This box displays the configuration currently stored in the selected
target.

Current

This box calculates the difference in joint values between the cur-
rently selected target and the preceding target in the path.

Change

Tip

Have this dialog box and the Modify Target dialog box open at the same time.
The configuration will then be automatically recalculated when the target is
modified, which will help you determine how much you can adjust the target
while keeping it within reach.

How to Set Configuration
Cutting PowerPac provides two ways to set a configuration for a target.

• Specify a configuration setting by selecting a combination of arm, wrist and
tool configuration among the symbols on the control. The settings will be
used to find the robot configuration that fits the selection best.

• Manually select a robot configuration among all the possibilities given. This
is done by selecting one of the robot configurations in the drop-down New.
The configuration setting controls will then be updated accordingly.

When selecting a configuration, the selected symbol gets a frame around it, and
the selection process will make the background white for the valid configuration
that was selected. If the two (the frame and the white background) does not
coincide, the selection could not be fulfilled.

xx1300001295
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Tip

To set the configuration for a cutting path:
1 Create a cutting path with the approach point as a joint move. Make all other

moves linear
2 Set the configuration for the first target (the joint move).
3 Run through all the targets using the Move To function.
4 If there is a problem, modify the configuration of the first target and repeat

the step 3.

Related Information
Path View toolbar general introduction on page 96.
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6.3.7 Simulation

Overview
The simulation buttons in Path view window are: Jump to, Move to, Execute Move
Instruction, Simulate. For detailed information, see Path View toolbar on page 96.
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6.3.8 The Options Menu

Overview
Select simulation options for the executed paths.

Enable Log
Use this procedure to enable log:

1 On the path view toolbar, select the check box of Enable Log from the
Options menu.

2 Click the Simulate button.
3 When the execution finishes, the Simulate Log window is displayed. View

the simulate logs in this window.

xx1300001296

DescriptionItem

Collision events happened during simulation in RobotStudio
3D environment are listed here.

Collisions

You need to first create collision set including interesting objects
by using RobotStudio functions.

RobotStudio and Virtual Controller events, for example, motor
on/off, I/O changes, program start/stop, raised during simulation
are listed here.

Events

Data about TCP robots' motion details during simulation are
listed here.

Robot Motions

Each data item represents the running robot motion information
on a simulation step, including time stamp, TCP position, joint
angles and joint value percentage relative to the respective joint
limits.
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DescriptionItem

Data about external axes' motion details during simulation are
listed here.

External Axes Motions

Each data item represents the running external axes' motion
information on a simulation step, including time stamp, and
joint angles.

Controls to play, pause and reverse play the log.Play Controls

Check to enable robots' automatic JumpTo when an data item
is selected by keyboard or mouse clicking.

Auto JumpTo

There also would be a CutWare Graph Tool window displaying to show parameters
as motor speed, motor torque, TCP speed etc.. See the picture below.

xx1300001302

The x axis of the coordinate is time, items for y axis can be selected from the top
left drop down list. After the selection and click on the diagram displayed, the
corresponding information would be displayed in the graph and the text field on
the top of the interface.

Save As Viewer
This function can save the simulation process as an .exe file used for replaying
the simulated cutting process. Use this procedure to save the simulation of the
executed paths as a RobotStudio viewer file:

1 On the path view toolbar, select the check box of Save As Viewer from the
Options menu.

2 Click the Simulate button.
When the execution finishes, the Save As dialog box opens.

3 In the dialog box, specify the name and location for the viewer file.
4 Click Save.

Auto View-Center On
When this function is checked, the simulation view interface would automatically
be put as the view center in the simulation process.
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6.3.9 Export Process Section

Overview
One or more cutting paths can be exported as a XML file, and then imported into
other part programs in the same or different station. This feature greatly reduces
duplicate work when paths between parts or stations are similar.

How to Export a Process Section
To export process sections, follow these steps:

1 To export a single cutting path, right click on the Process Start target, or
select a complete process section. To export multiple cutting paths, select
a complete range with equal numbers of Start and End targets. Right click,
and select Export Process Section(s).
If a single process section is selected, a user message will appear for you
to select if the path should be saved as a template.

xx1300001303

If a process section is saved as template, you will be able to modify the
approach or depart offset, path angle/offset when importing the saved file.
Otherwise, you will only be able to import and create new path targets as
they were exported.
A dialog box appears.

2 Specify the XML file name and directory. If a path is saved as template, the
default name should be "Template_" + Task name + Path name + "Ind_" +
index of first target + "_" + index of last target; otherwise, the name is
"Section_" + Task name + Path name + "Ind_" + index of first target + "_" +
index of last target. The default directory is under the "/My
Documents/RobotStudio/Stations".

xx1300001304
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3 Click Save and an exporting dialog box opens.
4 Complete the dialog box, click OK, and an XML file will be created.

xx1300001305

DescriptionObject

Describes the name of the station, the task, and the start index
and end index of the targets in the exported process sections.
Read-only.

Description

The directory in which the file is stored. Read-only.Path

The name of the saved file. Read-only.File Name

Select a reference that the path targets in the process sections
are related to. This affects the position and rotation values of
these targets. The references can be World Coordinate, User
Coordinate System, robot base coordinate, or work object co-
ordinate, and also the RCS of the first target.

Reference Frame

The included paths to be exported are listed here.Included Paths
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6.4 Verify and modify

6.4.1 Overview

Overview
Verify and modify procedure is done together with the path view and simulation in
the Path view window.

xx1300001306

Instruction icons in the Path View notify you if a target is out of reach by changing
the target color to red. If the target is within the reach of the robot, the target color
changes to yellow.
The path is tested and verified by pushing the buttons in the toolbar of the path
view. A successfully executed path displays all the targets in green color.
If an execution is failed, it is possible to tune the individual target position,
orientation, and other instruction attributes. Changes are checked by executing
the path again. This procedure is repeated until all the targets are tested and
verified, that is, all the targets in the Path View are green.

Verifying

DescriptionActivity

Open the selected path in the Path View to
show targets and instructions.

1

See Path View toolbar general intro-
duction on page 96for the detailed
description.

Click the Jump to Target. Move to Target or
Simulation button in the Path View toolbar to
test the selected targets.

2

Modifying
When the robot can not reach all targets in the path or users want to optimize the
path, modification can to be done.
See Modify instructions on page 115 for a detailed description.
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7 Path optimization
7.1 Overview

Overview
After cutting paths are created, Optimization can be done to make the robot can
reach all cutting targets and implement cutting process.
You can use following procedure to optimize paths using the cutting browser and
the Optimization group on the Cutting ribbon tab.

1 Right click the path in the cutting browser and select Check Path to test the
reachability and collision status of the cutting path. Detailed information,
please see Check path on page144. The collision check function is included
in Check Path function. For how to create a collision set, see Collision Set
on page 66.

2 Click theMove To Path button in theOptimization tab of the ribbon to check
if the robot can move to all the cutting targets.

3 If the robot can not successfully move to all targets, right click the path and
select Edit to edit the path section in the Edit PathSection window until the
robot can move to all the targets.

Tip

If the robot still can not move to all targets on the path, users can use view the
path with robot simulation using the Path viewwindow. For detailed information,
please see Path view on page 91.
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7.2 Check path

Overview
Click the Check Path button of the Optimization group in the cutting ribbon tab,
the Path View interface would show instruction icons presenting cutting targets.
Users can know what type of error the target is by its icon.

xx1300001176

For detailed description for items on the Path View ribbon tab, please refer to Path
View toolbar general introduction on page 96.
For detailed information about instruction icons, please refer to Instruction icons
in the path on page 92
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7.3 Collision check

Overview
Users can check if collision exists during the cutting process. For how to setup
collision set, please see Collision Set on page 66.
If collision exists during the simulation of cutting process, the components that
have collision would turn to red in simulation. You can also know collision error
existing by the instruction icons. Targets with collision error would have an
exclamation mark in the icon. For description for instruction icons in cutting path,
please see Instruction icons in the path on page 92.

Note

To view the collision status of cutting paths, the collision set must be created.
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8 Data management
8.1 Overview

Task group
The functions in this group are related to the active task.

xx1300001165
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8.2 Data manager

Data Manager
Click Data Manager to open the data edit interface. You can:

• Compare the data in the station with the date in the virtual controller.
• Synchronize data from the virtual controller to the station.
• Synchronize data from the station to the virtual controller.
• Modify data other than default, such as fricdata, leaddata, and LsCutData.

xx1300001166

Synchronize data between virtual controller and station
Synchronizing ensures that the RAPID program in the system, running on the
virtual controller, corresponds to the programs in Cutting PowerPac. You can
synchronize data both from the station to the virtual controller and from the virtual
controller to the station.
To synchronize the entire program stored in a robot system from the virtual
controller to the station, follow these steps:

1 Select a task node from the Cutting browser, and clickData Manager to open
the Data Manager interface.

2 Click Synchronize to Station.
To synchronize specific data between the virtual controller and the station, follow
these steps:

1 Select a task node from the Cutting browser, and click Data Manager on the
ribbon to open the data edit interface.

2 Click the "+" signs to expand the modules.
3 Click the data that you want to synchronize. An editor opens where you can

view the data expression.
4 Click the up arrow to synchronize the data from the virtual controller to the

station.

Continues on next page
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5 Click the down arrow to synchronize the data from the station to the virtual
controller.

xx1300001167

Note

• For data that is just created but not shown in the virtual controller, you can
specify the type in virtual controller when synchronizing. The type can be
Persistent, TaskPersistent, Constant, or Variable. For the data
that is already shown in the virtual controller, this function is disabled.

• Only data of type other than robtarget and jointtarget can be
synchronized from the virtual controller to the station.

Note

One of the features in Cutting PowerPac is the multilevel synchronization. You
can choose to synchronize an entire task, a part program, or a path to the virtual
controller.

Modify data
To modify data in the data edit interface of Data Manager, follow these steps:

1 Select a task node from the Cutting browser and click Data Manager to open
the Data Editor.

2 Click the “+” signs to expand the modules.
3 Double click the data that you want to modify. A Data Editor opens where

you can view the data expression. In Data Editor, you can modify the
synchronize reference, the storage class in RAPID programs, and the values
of the data itself.

4 Modify the data.
5 Click OK to make the changes take effect.

Continues on next page
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Each data item has a classification that is used to define in which modules data
should end up in the virtual controller. The data classification will be used to set
the module name property when the data is synchronized to the virtual controller.

• Sync as Inline Data: This selection is only available for jointtargets and
robtargets. The data will not be declared but included in the instruction.

• Sync to Program Module: The default setting for most data. The data will
be synchronized to the same module as the procedure where it was used.

• Sync to Process Data Module: Default setting for data such as leaddata.
The data will be synchronized to themodule defined as Process DataModule,
See task properties.

• Sync to Calibration Data Module: Default setting for data such as tooldata.
The data will be synced to the module defined as Calibration Data Module,
See task properties.

• Sync to Module: Name of the procedure to where the data will be synced.
No update will be done during synchronization.

Note

The Storage Class selection is enabled only if data does not exist in the virtual
controller; otherwise it will simply use the storage class of the data in the virtual
controller.
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8.3 Laser table

Overview
You can manage the laser table with the Laser Table function in Data.
Click the Laser Table button in the Task group of Cutting ribbon tab, the Cutting
Table Checking window is displayed.
By this interface, users can:

• Check if the LS TableConf are valid or not.
• Create and Edit LS cutting parameter tables.
• Create and edit LS TableConf.

xx1300001168

DescriptionObject

The task which contains the instruction that using a LS TableConf.Task

The part that contains the instruction that using a LS TableConfTableConf.Program

The path that contains the instruction that using a LS TableConf.Path

The instruction that using a LS TableConf.Instruction

ID of the instruction in a multimove system.ID

Targets in the cutting path.ToPoint

List of TableConfs. For more information, see LS Cutting parameter tables
on page 39.

LS Table-
Confs

Displays if the LS TableConf is valid or not. There are three types of status:
Good, Out of range and Invalid table.

Status

Displays the LS Cutting parameter table that currently is active and the
quantities of laser and piercing groups inside the table.

Active Table

Continues on next page
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DescriptionObject

Displays the list of LS cutting parameter tables. You can execute CREATE,
EDIT, COPY, DELETE, IMPORT operation to the LS cutting parameter tables
and set the active table. For more details, see LS Cutting parameter tables
on page 39.

LS Cutting
Parameter
Tables

Check the valid status of LS TableConf
Check the Status column in the Cutting Table Checking interface, the valid status
of the LsTableConf is displayed.
If the TableConf is valid, Good is displayed.
If the TableConf is valid but the table configuration is out of range, that is, exceed
the maximum number of cutting or piercing groups in the table, Out of range is
displayed.
If currently there is no active LS cutting parameter table, then Invalid table is
displayed.
When the status of the TableConf is Out of range, users need to change the
TableConf according to the following procedures:

1 View the LS cutting parameter table and check the quantity of its cutting
groups and piercing groups. For detailed information about viewing the LS
cutting parameter table, see Edit LS Cutting parameter tables on page 43.

2 Open the instruction that using this Ls TableConf and edit the TableConf or
use another TableConf or create a new one. For detailed information, see
Edit LS Cutting parameter tables on page 43.

When the status of the LS TableConf is Invalid table, users need to set the active
LS cutting parameter table. For more details, see Edit LS Cutting parameter tables
on page 43.
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9 Synchronize
Overview

It is important to keep the virtual controller and the Cutting PowerPac in
synchronization, which requires exact mapping between the graphical objects and
the RAPID language. For example, a target in the graphical environment generates
a robtarget definition and amove instruction in the virtual controller; a path including
targets in the graphical environment generates a routine with move instructions in
the virtual controller.

Workflow
Following is the basic workflow:

1 Create and modify targets and paths in the graphics environment.
2 Synchronize selected item to the virtual controller.
3 The resulting RAPID programs reside in the virtual controller and is ready

for download to the real controller.
One of the feature in Cutting PowerPac is the multilevel synchronization. You can
choose to synchronize an entire task, a part program, or a path to the virtual
controller.
In the case of MultiMove system the child levels to be synchronized depend on
the task that is being selected. For example, if task 1 (T_ROB1) is selected the
Synchronize to RAPID window pre-selects only T_ROB1 and its child levels. But
you can select other child levels of another task according to your requirement.

xx1500001906
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10 Path simulation
10.1 Path simulation using the cutting ribbon tab

Path simulation using the cutting ribbon tab

xx1300001301

The Simulation group on the Cutting ribbon tab has the following functions:
• Play, pause, stop, and reset the simulation of the cutting process.

For more details, see The Cutting ribbon on page 24.
To simulate a cutting process using the Cutting ribbon tab, use the following
procedure:

1 In the Simulation group, click the Synchronize to RAPID icon and
synchronize the cutting program to the virtual controller.

2 Click the Simulation ribbon tab and setup the simulation.
3 On the Cutting ribbon tab, in the Simulation group, click the Play button to

start the simulation.

Note

You can directly simulate all the open paths using the Path view window. For
more details, see Path View toolbar on page 96 and Verifying on page 142.
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11 Virtual controller settings
11.1 Save Program

Saving a program
After synchronization, RAPID programs are stored in virtual controller. You can
access these programs from theOffline tab of RobotStudio. For more information,
see Operating manual - RobotStudio. You can also save the programs as files on
your PC, which makes it possible to load them to other controllers, or real IRC5
controllers.
Click Save Program to save the programs in virtual controller as files. The RAPID
programs are saved under "HOME" directory of the system folder.

Note

When saving a program to files, the RAPID program stored in the virtual controller
is saved. To savemodifications in the station, first synchronize them to the virtual
controller, and then click Save Program.

Load program to real controller
After synchronization, the fully functional RAPID program is generated in the virtual
controller and can be saved to files and later downloaded to a real controller using
the Online ribbon-tab. For more details about synchronization and downloading,
consult the Operating manual - RobotStudio.
This is the basic workflow:

1 Synchronize the tasks to the virtual controller to generate RAPID program.
2 Save the programs to files by clicking Save Program on the Cutting

ribbon-tab.
3 Copy the files to the real controller or download to real controller by using

the Online ribbon-tab. See Operating Manual - RobotStudio for detailed
procedure.

There are some files needing to be manually copied from My
Documents/RobotStudio/Systems/[folder with the name of the user system]/Home
to the corresponding locations in the real controller:

• The folder of LsCuttingParamTables.
• The .pfg file in the folder named by the name of the station.
• The screenshot picture for calibration.
• TpsView_Calibration.dll and TpsView_Calibration.gtpu.dll used for calibration.
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11.2 Options

Options

xx1300001164

Click Options to open a dialog box, which contains the following options:

DescriptionItemGroup

Synchronization option.Enable RC Mode
If selected, this option is enabled for all the tasks in
the current station. It means that for variables that
already exist in the virtual controller, synchronization
will not override them. Only new variables are created.

Allows you to enable or disable the process option.
Used for offline simulation.

Process OnCutWare
State

Allows you to enable or disable the cut process option.
Used for offline simulation.

Cut Process On

Allows you to enable or disable the friction tuning op-
tion. Used for offline simulation.

Friction Tune

Allows you to enable or disable the Ilc option which
will replace the previous Ilc setting. Used for offline
simulation.

Ilc Init

Allows you to enable or disable the Ilc option which
will calculate the new Ilc data based on the previous
Ilc settings. Used for offline simulation.

Ilc Continue

Allows you to enable or disable the log file option.
Used for offline simulation.

Create LogFile

Allows you to clear the path memory.Reset Path Memory

Specify the fraction number of output data in cutting
instructions

Output Decimal
Number
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